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1   Primeros pasos

El software Kodak Capture Pro es la opción perfecta para el procesamiento de 
imágenes y formularios, para las aplicaciones de flujo de trabajo y como 
aplicación independiente. Gestiona la digitalización a una y dos caras, la 
indexación y la creación de lotes en color, blanco y negro y/o escala de grises. 
Los lotes se pueden exportar fácilmente a una gran cantidad de aplicaciones 
comunes. El software Capture Pro permite aprovechar al máximo las 
capacidades de los escáneres para obtener la máxima productividad. Todas 
las funciones están disponibles en el software. No se requiere ninguna 
aceleración especial de hardware.

El software Capture Pro se ha diseñado para ser una herramienta rápida, 
precisa y fácil de usar. Proporciona un rendimiento óptimo del escáner y una 
productividad máxima. Una pantalla para múltiples páginas a alta velocidad 
presenta las imágenes y datos opcionales de índice a medida que se 
digitalizan los documentos. Incluye un conjunto completo de herramientas 
basadas en iconos que permiten simplificar la gestión de la digitalización. 

Esta guía proporciona los pasos básicos para crear un lote nuevo, digitalizar 
documentos, editar las imágenes escaneadas y generar un lote. Además, se 
detalla una descripción de las ventanas, los menús y las herramientas.

Documentación 
relacionada

Además de esta Guía del usuario, está disponible la documentación que se 
especifica a continuación.

• Ayuda en línea: Proporciona información sobre el producto, incluidos la 
instalación detallada del producto, detalles sobre su interfaz y muchas 
funciones avanzadas. Para encontrar esta información en el archivo de 
ayuda, puede utilizar la tabla de referencia del contenido, el índice o la 
función de búsqueda. 

Para acceder a la ayuda, presione F1, seleccione el botón Ayuda en un 
cuadro de diálogo o haga clic en el icono ? de la esquina superior derecha 
de cualquier ventana.

• Guía de inicio rápido: Ofrece una serie de procedimientos básicos 
y sencillos para empezar a utilizar el software de inmediato, incluidos la 
instalación y el inicio del software Capture Pro, así como los procedimientos 
para digitalizar mediante configuraciones de trabajo predefinidas 
y predeterminadas. Hay un PDF de esta guía en la sección de 
manuales y guías de la página web de asistencia del software Capture Pro: 
https://support.alarisworld.com/capture-pro-software#Manuals

• Guía del administrador: Ofrece información detallada sobre la creación de 
configuraciones de trabajo, que permitirán a los usuarios hacer un uso más 
eficiente del software Capture Pro. Además, incluye información sobre la 
configuración de páginas, códigos de barra y códigos de parche, 
importación automática y más. Hay un PDF de esta guía en la sección de 
manuales y guías de la página web de asistencia del software Capture Pro: 
https://support.alarisworld.com/capture-pro-software#Manuals

• Network Edition Guía del sistema: Incluye los procedimientos de 
instalación del software Capture Pro Network Edition. Puede encontrar un 
PDF de esta guía en la sección Manuales y guías de la página de asistencia 
del software Capture Pro: https://support.alarisworld.com/capture-pro-
software#Manuals

https://support.alarisworld.com/capture-pro-software#Manuals
https://support.alarisworld.com/capture-pro-software#Manuals
https://support.alarisworld.com/capture-pro-software#Manuals
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• Notas de la versión: Contienen información que puede no estar disponible 
en otra documentación de ayuda. Para acceder a las notas de la versión, 
visite www.kodakalaris.com/go/kcsdownloads y desplácese a la sección 
Estación de trabajo/Software cliente del sitio web.

Terminología Antes de comenzar, resulta útil obtener un conocimiento básico de algunos 
términos empleados en el software Capture Pro. 

El software Capture Pro se basa en “trabajos”. Un trabajo es una 
configuración que se crea para capturar y procesar un conjunto de 
documentos que se quiere digitalizar. 

A fin de digitalizar los documentos de un trabajo, es necesario crear un lote 
para retener los documentos digitalizados, las imágenes y los datos antes de 
generarlos.

El software Capture Pro organiza los documentos digitalizados en la jerarquía 
que figura a continuación.

• Lote: Contiene uno o más documentos digitalizados (de modo similar a una 
carpeta o a un archivo abarcador con varios documentos por separado).

• Documento: Contiene una o más páginas relacionadas con un único 
elemento (p. ej., el contenido de un sobre).

• Página: Las hojas físicas de papel que se alimentan a través del escáner 
para producir imágenes.

• Imagen: Representación electrónica de las páginas digitalizadas.

Generar significa enviar el lote al sistema y a la ubicación de generación 
deseados en el formato elegido.

Cómo iniciar el 
software Capture Pro

Si no está utilizando las ediciones de solo índice o importación automática, 
asegúrese de que el escáner esté encendido y conectado correctamente al 
equipo. Si ha adquirido una clave de hardware opcional, asegúrese de que 
esté insertada en un puerto USB del equipo. 

NOTAS:

• Los clientes Network Edition le informarán de que están obteniendo una 
licencia.

• Los clientes del software Capture Pro Network Edition llevarán a cabo una 
sincronización inicial con el software Capture Pro Server.

• Haga doble clic en el icono del software Capture Pro del 
escritorio o

• vaya a: Inicio > Programas > Kodak > Software Kodak 
Capture Pro.
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Selección del 
escáner

La primera vez que inicie el software Capture Pro, se mostrará el siguiente 
mensaje: No se ha seleccionado el escáner. ¿Desea configurarlo ahora? 
Haga clic en Sí para acceder a la pantalla Configuración de la estación de 
trabajo. En esta pantalla, puede seleccionar el escáner que utilizará de la lista 
de escáneres disponibles. En posteriores inicios del software, se omitirán 
estos pasos.

1. Haga clic en Select (Seleccionar). Aparecerá la pantalla Select Scanner 
(Seleccionar escáner).

2. Seleccione el escáner que ha instalado en el equipo y haga clic en OK 
(Aceptar). Se mostrará la pantalla Inicio rápido.

3. Haga clic en Aceptar en la pantalla Configuración de la estación de 
trabajo.

4. Seleccione Importación automática si desea importar las imágenes 
a Capture Pro sin usar un escáner físico o la intervención manual.
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Inicio rápido La pantalla Inicio rápido ofrece un menú con las funciones de usuario y los 
iconos de trabajo más utilizados.

La página de iconos de trabajo muestra las configuraciones de trabajo que se 
han creado. Los iconos se muestran en orden alfabético y pueden cambiar de 
color si se agregan o eliminan otros iconos de trabajo.

NOTA: Los nombres de trabajo con mayor longitud no caben en el botón 
y aparecerán recortados. Al mover el mouse sobre el botón, se 
mostrará el nombre completo del trabajo. Se recomienda que las 
primeras palabras del nombre del proyecto sean unívocas 
y descriptivas.

Batch Manager (Administrador de lotes): Permite abrir lotes de documentos 
existentes, crear nuevos lotes o ver el estado de cualquier lote existente.

Main Menu (Menú principal): Muestra la pantalla principal del software 
Capture Pro. Puede abrir o crear un lote nuevo de forma manual, iniciar la 
captura de un documento, editar las configuraciones de trabajo, editar 
usuarios y grupos, y realizar numerosas tareas de configuración del sistema.

Logout (Cerrar sesión): Permite cerrar la sesión del usuario actual.

Exit (Salir): Cierra el software Capture Pro.

Al hacer clic en un icono de trabajo, se crea un nuevo lote y se inicia la 
digitalización según los ajustes establecidos en la configuración de trabajo. 
Una vez que se haya generado el trabajo, la pantalla Inicio rápido se volverá 
a mostrar.

NOTAS: 

• Si tiene experiencia en el uso del software o no desea utilizar los iconos de 
trabajo de la pantalla Inicio rápido, puede desactivar dicha pantalla. Para 
ello, anule la selección de la opción Vista de inicio rápido en el cuadro de 
diálogo Configuración de la estación de trabajo. Para acceder al cuadro de 
diálogo Configuración de la estación de trabajo, seleccione Archivo > 
Configuración de la estación de trabajo en la pantalla principal. 

• El icono de inicio rápido de la barra de herramientas Vista se puede utilizar 
para volver a la pantalla de inicio rápido desde el menú.

• La opción de inicio rápido está desactivada en las ediciones de solo índice 
e importación automática.
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Cuadro de diálogo 
Administrador de 
lotes

Si no está disponible la Vista de inicio rápido cuando inicia sesión en el 
software Capture Pro, aparecerá el cuadro de diálogo Administrador de lotes. 
Para mostrar el cuadro de diálogo Administrador de lotes, también es posible 
seleccionar Lote > Abrir. Utilice este cuadro para gestionar todos los lotes 
asociados a sus configuraciones de trabajo.

Available jobs (Trabajos disponibles): Detalla todas las configuraciones de 
trabajos. Seleccione un lote de cualquiera de estas configuraciones de 
trabajos.

Batches of the selected job (Lotes del trabajo seleccionado): Muestra los 
campos Job Name (Nombre del trabajo), Batch Name (Nombre del lote), 
Time Created (Hora de creación), Batch Status (Estado del lote) y Locked By 
(Bloqueado por) de los trabajos seleccionados.

Show Options (Mostrar opciones): Muestra el cuadro de diálogo Mostrar 
opciones, que le permite seleccionar qué estados (es decir, Disponible, 
Procesamiento, etc.) se mostrarán en el campo Estado del lote en el cuadro 
de diálogo Administrador de lotes.

Open (Abrir): Muestra el lote que seleccionó de la lista. El comando Open 
(Abrir) no abrirá ningún lote que figue como In Use (En uso). Para abrir un lote 
actual, debe tener permisos de lectura/escritura para la ubicación de la 
imagen digitalizada.

New (Nuevo): Muestra el cuadro de diálogo Nuevo lote, que permite crear un 
nuevo lote.

Haga clic para mostrar todos los lotes de todas las 
configuraciones de trabajo.

Haga clic para ocultar todos los lotes de todas las 
configuraciones de trabajo.
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Rename (Renombrar): Muestra el cuadro de diálogo Cambiar nombre de lote, 
que permite cambiar el nombre al lote seleccionado.

Delete (Eliminar): Elimina el lote seleccionado. Aparecerá un cuadro de 
confirmación para que confirme la eliminación.

Output (Generar): Envía el lote para su procesamiento. 

NOTA: En el caso de las licencias de grupo A y B, debe haber un escáner 
físico conectado para generar lotes. Si necesita generar lotes sin un 
escáner conectado, puede adquirir una licencia de indexación.

Close (Cerrar): Cierra el cuadro de diálogo.

Creación de un 
nuevo lote

Cuando quiera digitalizar documentos, debe crear un lote nuevo o abrir uno 
existente en el que digitalizar los documentos. En la mayoría de casos, el 
administrador del sistema ya habrá configurado los trabajos que utilizará. 
Estos trabajos aparecerán en el cuadro de diálogo Administrador de lotes.

Para crear un nuevo lote:

1. Ejecute el software Capture Pro. Se mostrará el cuadro de diálogo Batch 
Manager (Administrador de lotes).

2. Seleccione New (Nuevo). Se mostrará el cuadro de diálogo New Batch 
(Nuevo lote).

3. Seleccione una configuración de trabajo en la lista desplegable Job name 
(Nombre del trabajo). El nuevo lote se capturará y saldrá tal y como se 
haya definido en la configuración de este trabajo.

4. Si corresponde, introduzca un nombre nuevo para el lote en el campo 
Batch name (Nombre del lote). De manera predeterminada, el software 
Capture Pro sugiere un nombre para el nuevo lote con base en el nombre 
del lote anterior creado para la configuración de trabajo. Por ejemplo, si el 
nombre del último lote es Salud030, el nombre predeterminado del nuevo 
lote será Salud031.
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NOTA: Para clientes de Network Edition. Cuando Activar numeración 
de lote de nivel de trabajo está desactivado en Configuración 
de estación de trabajo y el nombre de lote incluye 
<BATCH_COUNTER>, el nombre del lote muestra el texto 
Establecido por el sistema y no se puede cambiar.

5. Si corresponde, complete el campo Starting document ID (ID de 
documento inicial). El identificador de documento inicial es el identificador 
que quiere asignar al primer documento de un lote. En la mayoría de los 
casos, ese identificador es 1. De forma predeterminada, el software 
propone un número inicial de documento creado a partir de la 
configuración del trabajo.

6. Haga clic en OK (Aceptar). El visor de imágenes se mostrará en la 
ventana principal con el nombre de lote que se asignó. El visor de 
imágenes, el explorador de lotes y el visor de miniaturas permanecerán 
vacíos hasta que comience la digitalización.

7. También puede crear un nuevo lote haciendo clic en el icono Nuevo lote 
de la barra de herramientas.

Cómo abrir un lote 
existente

Para abrir un lote existente:

1. Seleccione Batch > Open (Lote > Abrir). Se mostrará el cuadro de diálogo 
Batch Manager (Administrador de lotes). Según los valores de 
configuración, se mostrarán los lotes de todas las configuraciones de 
trabajo.

2. Resalte el lote que quiera abrir y haga clic en Open (Abrir). El lote que 
seleccionó aparecerá en el visor de imágenes y en el explorador de lotes. 
A partir de ahora, puede trabajar con este lote.

3. Al hacer clic en el icono Abrir lote, aparece el cuadro de diálogo Batch 
Manager (Administrador de lotes).

NOTA: Si está digitalizando en un entorno de varios escáneres y el lote 
que seleccionó ya está abierto en otra estación de trabajo, el 
software Capture Pro no le permitirá abrirlo. Aparecerá el mensaje 
No se puede abrir el lote, ya que actualmente lo está 
utilizando otro usuario. 
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Eliminación de un 
lote

Eliminar un lote implica que se borran la estructura de subdirectorio y las 
imágenes del lote seleccionado.

1. Seleccione Batch > Open (Lote > Abrir). Se mostrará el cuadro de diálogo 
Batch Manager (Administrador de lotes). Según los valores de 
configuración, se mostrarán los lotes de todas las configuraciones de 
trabajo.

2. Resalte el lote que desee eliminar y haga clic en Delete (Eliminar). 
Aparecerá el mensaje ¿Confirma que desea eliminar el lote 
seleccionado “XXXXX”?.

3. Haga clic en OK (Aceptar).
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Cómo usar un trabajo Esta sección detalla los pasos básicos para crear, digitalizar y generar un lote. 
Hay información detallada sobre la indexación, la configuración de zonas de 
OCR, la lectura de parches, la selección de fuentes de generación distintas, 
etc. en la Guía del administrador del software Kodak Capture Pro.

NOTA: Con el software Capture Pro, es posible llevar a cabo una acción de 
diversas maneras. Por ejemplo, si desea abrir un lote, puede 
seleccionar Batch > Open (Lote > Abrir) en la barra del menú, puede 
hacer clic en el botón de la barra de herramientas Abrir lote o puede 
presionar la tecla de método abreviado del teclado F3. Para los fines 
de este manual, todas las acciones se describen con el uso de la 
barra de menús. Para obtener una lista completa de menús, botones 
de la barra de herramientas y teclas de función, consulte “Interfaz de 
usuario” en la página 17.

1. Si aún no ha iniciado el software Capture Pro, hágalo ahora. Se mostrará 
el cuadro de diálogo Batch Manager (Administrador de lotes).

2. Haga clic en New (Nuevo). Aparecerá la pantalla New Batch (Nuevo lote).

3. Seleccione la configuración de trabajo que desee en el cuadro 
desplegable Job name (Nombre del trabajo). Los campos Batch name 
(Nombre del lote) y Starting document ID (ID de documento inicial) se 
completan automáticamente. Si lo desea, puede modificarlos. 
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4. Haga clic en OK (Aceptar). Aparecerá la pantalla principal. Ya está todo 
listo para comenzar a digitalizar. 

5. Coloque la pila de documentos que quiere digitalizar en la bandeja de 
entrada del escáner.

6. Haga clic en Iniciar. El escáner alimentará las páginas.

7. Cuando se hayan digitalizado los documentos, podrá usar las opciones de 
edición necesarias (eliminar páginas en blanco, girar imágenes, recortar 
imágenes, etc.). Para obtener una breve descripción de algunas de las 
opciones disponibles, consulte “Opciones de edición” en la página 11.

8. Cuando el lote esté como lo desea, seleccione Batch > Output (Lote > 
Generar). Comienza la tarea de generación del lote. Aparecerá la pantalla 
Nuevo lote, lo que le permitirá iniciar otra sesión de digitalización con el 
procesamiento en segundo plano. 

NOTA: En el caso de las licencias de grupo A y B, debe haber un escáner 
físico conectado para generar lotes. Si necesita generar lotes sin 
un escáner conectado, puede adquirir una licencia de indexación.

Las imágenes digitalizadas se enviarán a la ubicación designada. 
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Opciones de edición Antes de generar el lote, revise las imágenes para estar seguro de que están 
como desea. Si necesita realizar algún ajuste, dispone de herramientas para 
hacerlo. En esta sección, se detallan los procedimientos para algunas de las 
funciones de edición utilizadas con mayor frecuencia (girar imágenes, eliminar 
imágenes, recortar imágenes, etc.). Los procedimientos para dividir 
y combinar imágenes se encuentran en la Guía del administrador del software 
Kodak Capture Pro. 

Todas las opciones de menú y las opciones de la barra de herramientas se 
describen en el Capítulo 2: Interfaz de usuario.

Rotación de las imágenes El software Capture Pro le permite girar automáticamente las imágenes 
a medida que se digitalizan o girarlas manualmente después de digitalizadas. 
Las imágenes giran 90°, 180° o 270° hacia la derecha.

Para girar imágenes manualmente en un lote existente:

1. Haga clic en imágenes individuales (o en grupos de imágenes) en la lista 
del explorador de lotes o en el visor de imágenes.

2. Seleccione Tools > Rotate > 90, 180 o 270 (Herramientas > Girar > 90, 
180 o 270). Las imágenes giradas se mostrarán en el visor de imágenes.
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Cómo dibujar una región La herramienta Dibujar región permite dibujar un rectángulo alrededor de una 
parte de una imagen, poner en blanco el área dentro del rectángulo mediante 
la opción Blank (En blanco) o recortar la imagen para ajustarla al tamaño del 
rectángulo con la opción Crop (Recortar).

1. Haga clic en una imagen que desee recortar o poner en blanco en el visor 
de imágenes.

2. Seleccione Tools > Draw Region (Herramientas > Dibujar región). 

3. Haga clic y arrastre el cursor de dibujar región para crear una rectángulo 
sobre la parte de la imagen que desee seleccionar. Suelte el cursor: el 
rectángulo aparece en verde.

4. Ahora, puede recortar la región o ponerla en blanco.

Para eliminar una región:

• Haga clic con el botón secundario sobre la imagen que contiene el rectángulo 
verde y seleccione Deselect Region (Cancelar selección de región).

Cómo recortar imágenes Mediante la opción Recortar, puede recortar un área fuera de una región 
rectangular que haya creado con la herramienta Dibujar región.

1. Haga clic en la imagen del explorador de lotes que desea recortar. 
La imagen que seleccione se resaltará en rojo en el visor de imágenes.

2. Seleccione Tools > Draw Region (Herramientas > Dibujar región). 

3. Haga clic y arrastre el cursor de dibujar región para crear una rectángulo 
sobre la parte de la imagen que desee guardar. Suelte el cursor: el 
rectángulo aparece en verde.

4. Seleccione Tools > Crop (Herramientas > Recortar). El área de la imagen 
fuera del rectángulo verde se eliminará y solo el área seleccionada 
permanecerá en el visor de imágenes.

5. Haga clic en Yes (Sí) para guardar la configuración.
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Poner en blanco una parte 
de la imagen

Si desea poner en blanco una parte de la imagen, puede dibujar una región en 
la imagen y usar la herramienta En blanco. El área dentro del rectángulo se 
pondrá en blanco. 

1. Haga clic en la imagen del explorador de lotes que desea poner en blanco.

2. Seleccione Tools > Draw Region (Herramientas > Dibujar región). 

3. Haga clic y arrastre el cursor de dibujar región para crear una rectángulo 
sobre la parte de la imagen que desee poner en blanco. Suelte el cursor: 
el rectángulo aparece en verde.

4. Seleccione Tools > Blank (Herramientas > En blanco). La imagen 
mostrará un área en blanco donde haya posicionado el rectángulo verde.

5. Haga clic en Yes (Sí) para guardar la configuración. 

Cómo agregar páginas Esta opción permite digitalizar páginas adicionales en un documento 
existente. 

1. En el explorador de lotes, seleccione el documento que recibirá la página 
agregada.

2. Haga clic en Document > Attach Page (Documento > Agregar página).

3. Digitalice las imágenes. Las páginas nuevas se mostrarán al final del 
documento seleccionado. 

Cómo volver a digitalizar 
imágenes

Al revisar el lote de imágenes digitalizadas, es posible que deba volver 
a digitalizar algunos documentos.

1. Resalte la página o las páginas que quiera volver a digitalizar.

2. Coloque los originales en el orden correcto en el escáner.

3. Haga clic en el icono Rescan (Volver a digitalizar). Las imágenes se volverán 
a digitalizar y se colocarán en las posiciones digitalizadas originales.

Cómo eliminar imágenes Si quiere eliminar las imágenes seleccionadas del lote:

1. Seleccione la imagen que quiere eliminar.

2. Seleccione Edit > Delete (Editar > Eliminar). Aparecerá el mensaje 
Are you sure you want to delete the selected item(s)? (¿Confirma que 
desea eliminar los elementos seleccionados?).

3. Haga clic en Yes (Sí) para confirmar la eliminación.
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Eliminación de un intervalo 
de documentos

Puede eliminar un intervalo de documentos de un lote existente.

1. Seleccione Document > Delete Range (Documento > Eliminar intervalo). 
Se mostrará el cuadro de diálogo Delete Documents in Range (Eliminar 
documentos del intervalo).

2. Introduzca el número inicial del grupo de documentos que desee eliminar 
en el campo From Document Number (Número del primer documento).

3. Introduzca el número final del grupo de documentos que desee eliminar en 
el campo To Document Number (Número del último documento).

4. Haga clic en OK (Aceptar).

Eliminación de imágenes 
en blanco de un lote

Esta opción permite eliminar las imágenes en blanco el reverso y el anverso 
producidas por el escáner.

1. Seleccione Batch > Remove Blank Images (Lote > Eliminar imágenes en 
blanco). Se mostrará el cuadro de diálogo Remove Blank Images Setup 
(Configuración de eliminación de imágenes en blanco).

2. En el campo Start at document (Empezar en documento), introduzca el 
número de documento inicial del lote en el que quiere empezar a buscar 
imágenes en blanco. El valor predeterminado es el documento activo en 
ese momento.

3. Defina el umbral de tamaño en bytes de las imágenes que se van 
a verificar en los campos Show Grayscale images below (Mostrar 
imágenes en escala de grises por debajo de) y Show Color images below 
(Mostrar imágenes en color por debajo de). Una configuración apropiada 
para los documentos empresariales más comunes es de 3000 bytes en 
200 ppp en blanco y negro.

4. Haga clic en Check only back sides (Comprobar solo reversos) para 
eliminar sólo los reversos en blanco de las imágenes de un lote.

5. Haga clic en Pre-select all (Preseleccionar todo) si todas las imágenes 
son candidatas para su eliminación.
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6. Defina el número de columnas y filas que desea mostrar en el campo 
Display layout (Diseño de visualización). En una pantalla SVGA de 1024 x 
768, una matriz de 14 x 7 permite verificar 98 imágenes por pantalla.

7. Haga clic en OK (Aceptar) para aceptar los valores introducidos. 

Después de examinado el lote, el software Capture Pro muestra todas las 
imágenes que coinciden con los criterios establecidos (por ejemplo, 
anversos con menos de 5000 bytes) en la ventana Remove Blank Images 
(Eliminar imágenes en blanco). Estas imágenes se muestran resaltadas en 
color rojo. Todas las imágenes en color se consideran imágenes en blanco 
y listas para su eliminación.

• Si no aparecen imágenes en blanco en la ventana Remove Blank 
Images (Eliminar imágenes en blanco), el software Capture Pro no 
encuentra imágenes del lote que coincidan con los criterios. Puede 
hacer clic en Setup (Configuración) en la ventana Remove Blank 
Images (Eliminar imágenes en blanco) para volver a abrir el cuadro de 
diálogo Remove Blank Images (Eliminar imágenes en blanco) 
e introducir números de umbral más altos (en bytes) para las imágenes 
en blanco y negro, color o escala de grises.

8. De forma predeterminada, todas las imágenes en blanco están marcadas 
en rojo y seleccionadas para su eliminación. Para seleccionar las 
imágenes en blanco que no desee eliminar, haga clic en cada una de 
ellas. La marca en rojo desaparece en estas imágenes.

9. Utilice los botones First Screen, Previous Screen, Next Screen y Last 
Screen (Primera pantalla, Pantalla anterior, Pantalla siguiente y Última 
pantalla) para desplazarse por todas las posibles imágenes en blanco 
del lote.

10. Haga clic en Remove (Eliminar). Aparecerá el mensaje Remove all 
selected images? (¿Desea eliminar todas las imágenes seleccionadas?).

11. Elija Yes (Sí) para confirmar la eliminación de las imágenes en blanco. 
El software Capture Pro elimina las imágenes en blanco que permanecen 
resaltadas en rojo, vuelve a paginar los documentos y actualiza el lote 
disponible y la capacidad del disco duro.
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Cómo generar (procesar) 
un lote

Cuando haya finalizado con los cambios de edición, el lote está listo para 
generarse.

El software Capture Pro le permite generar (o procesar) un lote por vez 
o generar todos los lotes disponibles al mismo tiempo. 

Para generar el lote actual en una configuración de trabajo:

1. Seleccione Batch > Output (Lote > Generar). 

Cuando el lote se incorpore en la cola de generación, aparecerá el cuadro 
de diálogo New Batch (Nuevo lote). Esto le permitirá digitalizar otro lote de 
documentos. 

NOTA: En el caso de las licencias de grupo A y B, debe haber un escáner 
físico conectado para generar lotes. Si necesita generar lotes sin un 
escáner conectado, puede adquirir una licencia de indexación.

2. Haga clic en OK (Aceptar) para continuar digitalizando las imágenes en el 
nuevo lote. Al generar un lote, se procesa según el destino de generación 
del sistema seleccionado en la pestaña Generar del cuadro de diálogo 
Configuración de trabajo. Normalmente, el lote se copia en una ruta de 
subdirectorio de generación.

Para generar todos los lotes disponibles en una configuración de trabajo actual:

• Seleccione Batch > Output All (Lote > Generar todo). Se mostrará el 
cuadro de diálogo Administrador de lotes, donde podrá seleccionar uno 
o más lotes y generarlos. 

Para ver el progreso de la generación:

• Seleccione Batch > View Batch Output Status (Lote > Ver estado de 
generación del lote). Aparecerá la ventana Alaris Capture Pro Batch 
Process Status (Estado del proceso de lotes de Alaris Capture Pro). 

La ventana ofrece una actualización sobre el progreso de los lotes a medida 
que se generan. Al generar en segundo plano, la digitalización asume una 
mayor prioridad. La generación se hará más lenta hasta que la digitalización 
finalice.

Cómo borrar los errores La ventana Batch Status (Estado del lote) de Capture Pro proporciona 
información sobre los lotes que se están preparando para su generación.

Para ver la ventana Batch Status (Estado del lote):

• Seleccione Batch > View Batch Output Status (Lote > Ver estado de 
generación del lote).

Para borrar los errores:

• Haga clic con el botón secundario sobre una entrada Batch Name (Nombre 
del lote) de la cuadrícula y elija Clear All Errors (Borrar todos los errores) 
o Clear Selected Errors (Borrar los errores seleccionados).



A-61992_es  Marzo de 2022 17

2   Interfaz de usuario

En este capítulo se describen la ventana principal de Capture Pro Software 
y la barra de menús, las barras de herramienta y los visores.

Ventana principal La ventana principal contiene los elementos siguientes.

1 Barra de título del programa: Proporciona el nombre de la configuración 
de trabajo.

2 Barra de menús: Proporciona los siguientes elementos de menú: File, 
Batch, View, Capture, Document, Edit, Tools, Index y Help (Archivo, Lote, 
Ver, Capturar, Documento, Editar, Herramientas, Índice y Ayuda).

3 Barras de herramientas: Proporcionan las siguientes barras de 
herramientas: Capturar, Lote, Ver, Documento, Navegación, Marcar, 
Editar e Índice.

4 Batch Explorer (Explorador de lotes): Muestra un listado de todas las 
carpetas de documentos, las páginas y los archivos de imágenes del lote. 

5 Image Viewer (Visor de imágenes): Muestra las imágenes de un lote. 
El visor de imágenes puede configurarse para mostrar 1, 2, 4, 8 o más 
imágenes al mismo tiempo.

6 Thumbnail Viewer (Visor de miniaturas): muestra miniaturas de todas 
las imágenes del lote.
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7 Pestaña Index (Índice): al hacer clic en esta pestaña (situada en el lado 
derecho de la ventana principal), aparece la ventana Index (Índice), 
donde se recogen índices a nivel de lote o de documento. 

8 Pestaña Information (Información): Al hacer clic en esta pestaña 
(ubicada a la derecha de la ventana principal), aparece la ventana 
Information (Información), que proporciona estadísticas detalladas sobre 
el lote, el documento, la página y la imagen.
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Barra de menús La barra de menús proporciona los siguientes elementos de menú: File, 
Batch, View, Capture, Document, Edit, Tools, Index y Help (Archivo, Lote, Ver, 
Captura, Documento, Editar, Herramientas, Índice y Ayuda).

Menú File (Archivo) El menú File (Archivo) incluye las siguientes opciones:

Job Setup (Configuración de trabajo): Muestra el cuadro de diálogo Job 
Setup (Configuración de trabajo), que le permite configurar todos los 
parámetros de una configuración de trabajo. Consulte la Guía del 
administrador del software Kodak Capture Pro para obtener más información. 
Método abreviado del teclado: J.

Page Setup (Configuración de página): Muestra el cuadro de diálogo Page 
Setup (Configuración de página), que le permite seleccionar una configuración 
de página predefinida o crear su propia configuración personalizada para la 
configuración de trabajo. El software Capture Pro incluye varias 
configuraciones de página predefinidas. La lista de configuraciones de página 
predefinidas varía según el escáner que utilice. Consulte la Guía del 
administrador para obtener más información.

Workstation Setup (Configuración de la estación de trabajo): Muestra el 
cuadro de diálogo Configuración de la estación de trabajo (Configuración de la 
estación de trabajo), que le permite seleccionar el escáner conectado al 
equipo para digitalizar documentos en el software Capture Pro. Si dispone de 
licencia, también puede seleccionar la opción de importación automática para 
importar automáticamente imágenes en el software Capture Pro. Para obtener 
información sobre los procedimientos, consulte “Cómo configurar la estación 
de trabajo” en la página 20.

Intelligent Job Select (Selección de trabajo inteligente): Muestra el cuadro de 
diálogo Intelligent Job Select (Selección de trabajo inteligente), que permite 
utilizar hojas de código de parche de función para cambiar automáticamente 
las configuraciones de trabajo o página durante la digitalización. Consulte la 
Guía del administrador para obtener más información.

Import Job Setup (Importar configuración de trabajo): Muestra el cuadro de 
diálogo Import (Importar), que permite importar una configuración de trabajo. 
Consulte la Guía del administrador para obtener más información.

Export Job Setup (Exportar configuración de trabajo): Muestra el cuadro de 
diálogo Export (Exportar), que permite exportar una configuración de trabajo. 
Consulte la Guía del administrador del software Kodak Capture Pro para 
obtener más información.

User Setup (Configuración de usuario): Muestra el cuadro de diálogo User 
Setup (Configuración de usuario), que permite al administrador configurar 
y gestionar los usuarios del software Capture Pro. Consulte la Guía del 
administrador para obtener más información.

Change Password (Cambiar contraseña): Muestra el cuadro de diálogo 
Change Password (Cambiar contraseña), que permite cambiar la contraseña.

Para cambiar una contraseña:

1. Seleccione File > Change Password (Archivo > Cambiar contraseña). Se 
mostrará el cuadro de diálogo Change Password (Cambiar contraseña).

2. Introduzca la Contraseña anterior y, a continuación, la Contraseña 
nueva.

3. Para confirmar su contraseña, ingrese la nueva contraseña en el campo 
Confirmar contraseña.

4. Haga clic en OK (Aceptar). 
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Language (Idioma): Permite seleccionar el idioma en el que se muestra la 
interfaz de usuario. Los idiomas admitidos son los siguientes: inglés, francés, 
italiano, alemán, portugués (Brasil), neerlandés, español, chino 
simplificado, chino tradicional, sueco, coreano, turco, checo, ruso, 
árabe, polaco y japonés.

Para cambiar el idioma:

1. Seleccione File > Language (Archivo > Idioma). 

2. Seleccione el idioma deseado. La interfaz de usuario se mostrará en el 
idioma seleccionado.

NOTA: El cuadro de diálogo de configuración del escáner (controlador 
TWAIN) puede mostrar caracteres de texto incorrectos cuando el 
idioma predeterminado es occidental y el usuario pasa a un idioma 
asiático. Para resolverlo, use las opciones regionales y de idioma del 
sistema y configure el idioma para programas ajenos a Unicode en el 
idioma asiático deseado.

Measurement System (Sistema de medida): Permite seleccionar el sistema 
imperial o métrico.

Print (Imprimir): Muestra el cuadro de diálogo Print Setting (Configuración de 
impresión) de la impresora seleccionada, lo que permite imprimir documentos 
digitalizados. Método abreviado del teclado: Ctrl + P.

Save As PDF (Guardar como PDF): Muestra el cuadro de diálogo Save As 
PDF (Guardar como PDF), que permite guardar imágenes digitalizadas en 
formato PDF con o sin capacidad de búsqueda.

Logout (Cerrar sesión): Permite cerrar la sesión del usuario actual.

Minimize to System Tray (Minimizar a bandeja del sistema): Minimiza la 
aplicación del software Capture Pro, pero no la cierra.

Exit (Salir): Cierra el software Capture Pro. Método abreviado del teclado: 
Alt + F4.

Cómo configurar la estación 
de trabajo

Cuando se selecciona File > Workstation Setup (Archivo > Configuración de 
la estación de trabajo), aparece la pantalla Workstation Setup (Configuración 
de la estación de trabajo). Desde esta pantalla, puede configurar la 
información de la estación de trabajo y elegir el escáner que quiere utilizar.
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1. Complete los campos ID (Identificación) y Name (Nombre) de su estación 
de trabajo. En un entorno de varios escáneres, la identificación y el 
nombre deben ser únicos.

2. Si el usuario ya tiene experiencia y no desea usar la pantalla de inicio 
rápido, puede desmarcar la casilla Quick Start View (Vista de inicio 
rápido). 

3. Haga clic en Select (Seleccionar). Se mostrará el cuadro de diálogo 
Seleccionar escáner, con una lista de escáneres y otras fuentes 
disponibles (como la importación automática) en función de la licencia 
utilizada. 

4. Seleccione la fuente que desee utilizar y haga clic en Aceptar. 

5. Complete el campo Disk warning level (Nivel de advertencia del disco) con 
un valor en megabytes (MB). Recibirá una advertencia si el espacio libre 
en el disco alcanza un nivel inferior.

6. Active la opción Enable Job level batch numbering (Habilitar 
numeración de lotes en trabajo) si quiere que se mantenga el número de 
secuencia de lote de forma independiente para cada trabajo. Si se activa 
esta opción, la numeración se mantendrá en el nivel del trabajo. Si no, se 
mantendrá en el nivel del sistema. Por ejemplo: 

7. Si marca la casilla Display confirmation message during manual 
deletion (Mostrar mensaje de confirmación durante eliminación manual) e 
introduce un tamaño de página en kilobytes (KB), recibirá una advertencia 
cuando intente eliminar una imagen que supere el tamaño de página 
especificado.

8. En la sección Automatic restart limit (Límite de reinicio automático), 
ingrese valores para los campos Threshold (Umbral) y Offset 
(Compensación) si desea que Capture Pro se reinicie automáticamente 
cuando se alcancen estos límites. 

Por ejemplo, si configura los valores Restart Threshold = 5 y Restart Offset 
= 2, Capture Pro se reiniciará tras escanear 7 páginas en la sesión actual.

Cuando se alcanza el umbral de reinicio, aparece un cuadro de diálogo de 
confirmación que indica que la cantidad de hojas escaneadas alcanzó el 
límite y le pregunta al usuario si desea continuar escaneando hasta 
alcanzar el valor de compensación antes de reiniciar. Si el usuario hace 
clic en Sí, se escanean 2 páginas más antes de reiniciar Capture Pro.

NOTA: Se recomienda que el umbral de reinicio no supere 8000.

9. Si el usuario hace clic en No, Capture Pro se reinicia inmediatamente y la 
opción Automatic restart limit (Límite de reinicio automático) aparece 
atenuada cuando se reanuda el escaneo.

Nivel de sistema Nivel de trabajo

Facturas FAC001 Facturas FAC001

Reclamaciones REC002 Reclamaciones REC001

Registros REG003 Registros REG001

Facturas FAC004 Facturas FAC002
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Menú Batch (Lote) El menú Batch (Lote) presenta las siguientes opciones:

New (Nuevo): Muestra el cuadro de diálogo Nuevo lote, que permite crear un 
nuevo lote.

Open (Abrir): Muestra el cuadro de diálogo Administrador de lotes, que 
permite abrir un lote existente. Método abreviado del teclado: F3. Para 
obtener información sobre los procedimientos, consulte “Primeros pasos” en 
la página 1.

Close (Cerrar): Cierra el lote abierto actualmente.

Rename (Renombrar): Muestra el cuadro de diálogo Cambiar nombre de lote, 
que permite cambiar el nombre del lote actual.

Remove Blank Images (Eliminar imágenes en blanco): Muestra el cuadro de 
diálogo Configuración de eliminación de imágenes en blanco, que permite 
eliminar los anversos o reversos en blanco que genere el escáner. Método 
abreviado del teclado: K. Para obtener información sobre los procedimientos, 
consulte “Primeros pasos” en la página 1.

Output (Generar): Comienza a procesar todas las imágenes del lote actual. 
Método abreviado del teclado: O. Para obtener información sobre los 
procedimientos, consulte “Primeros pasos” en la página 1.

NOTA: En el caso de las licencias de grupo A y B, debe haber un escáner 
físico conectado para generar lotes. Si necesita generar lotes sin un 
escáner conectado, puede adquirir una licencia de indexación.

Output All (Generar todo): Comienza a procesar todas las imágenes de todos 
los lotes del trabajo actual. 

View Batch Output Status (Ver estado de generación de lote): Muestra la 
ventana Estado del proceso del lote de Capture Pro, que ofrece información 
sobre el progreso de la generación de lotes. Consulte “Ventana Estado de 
procesamiento de lote” en la página 48.

Clear (Borrar): Borra todas las imágenes del lote, pero mantiene intacta la 
estructura de subdirectorios del lote.

Delete (Eliminar): Elimina las imágenes y la estructura de subdirectorios del 
lote seleccionado. Para obtener información sobre los procedimientos, 
consulte “Primeros pasos” en la página 1.

Delete to End of Batch (Eliminar hasta final del lote): Elimina todas las 
imágenes a partir de la imagen seleccionada hasta la última del lote.
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Menú View (Ver) El menú View (Ver) contiene las opciones siguientes:

Image Viewer Display (Visualización en el visor de imágenes): Permite 
seleccionar una cuadrícula de 1, 2, 4 u 8 imágenes para mostrarlas en la 
ventana principal. En caso de seleccionar Customize (Personalizar), se 
muestra el cuadro de diálogo Configuración de diseño personalizado, que 
permite especificar otro tamaño de rejilla.

Image Viewer Filter (Filtro del visor de imágenes): Permite especificar uno 
o más tipos de imágenes que se mostrarán en el Visor de imágenes de la 
ventana principal. Puede seleccionar una o más de las opciones siguientes: 
Front, Back, Black & White, Grayscale y Color (Anverso, Reverso, Blanco 
y negro, Escala de grises y Color).

Thumbnail Viewer Filter (Filtro del visor de miniaturas): Permite especificar 
uno o más tipos de imagen que se mostrarán en el Visor de miniaturas de la 
ventana principal. Puede seleccionar uno o varios de los filtros siguientes: 
Front, Back, Black & White, Grayscale y Color (Anverso, Reverso, Blanco 
y negro, Escala de grises y Color).

Thumbnail Image Size (Tamaño de las imágenes en miniatura): Muestra el  
cuadro de diálogo Configuración del tamaño de las imágenes en miniatura, 
que permite especificar el tamaño de cada miniatura que se mostrará en la 
ventana principal.

Image Viewer, Batch Explorer, Thumbnail Viewer, Information, Index 
y Status Bar (Visor de imágenes, Explorador de lotes, Visor de miniaturas, 
Información, Índice y Barra de estado): Estos comandos permiten seleccionar 
si el componente correspondiente se muestra en la ventana principal. 
El método abreviado del teclado para la barra de estado es Ctrl + S.

Toolbars (Barras de herramientas): Permite ver u ocultar las siguientes barras 
de herramientas: Capture, Batch, View, Document, Navigation, Flag, Edit 
e Index (Capturar, Lote, Ver, Documento, Navegación, Marcar, Editar 
e Índice). Puede encontrar información detallada sobre las barras de 
herramientas más adelante en este capítulo.

Icon Size (Tamaño de iconos): Permite definir un tamaño para los iconos, que 
puede ser Small (Pequeño), Medium (Mediano) o Large (Grande).

Icon Text (Texto de los iconos): Permite especificar si se mostrarán etiquetas 
de iconos y, de mostrarse, si aparecerán a la derecha de los iconos o debajo.

Zoom (Ampliar): Aumenta o reduce el tamaño en que se muestra la imagen. 

• Actual (Real): Muestra la imagen en tamaño real (un píxel digitalizado 
equivale a un píxel en el visor de imágenes).

• Zoom In (Acercar): Aumenta la imagen visualizada según el incremento 
especificado en el cuadro de diálogo Configuración de paso de 
acercamiento.

• Zoom Out (Alejar): Reduce la imagen visualizada según el incremento 
especificado en el Cuadro de diálogo Configuración de paso de 
acercamiento.

• Zoom Step (Pasos de ampliación): Muestra el cuadro de diálogo 
Configuración de pasos de ampliación, que permite especificar el 
incremento (15 %, 20 %, 25 %, 30 %, 35 % o 40 %) en el que cambia el 
tamaño de la imagen al usar los comandos Zoom In (Acercar) y Zoom Out 
(Alejar).
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Pan All Images to (Desplazar todas la imágenes a): Permite mover todas las 
imágenes en el panel del visor de imágenes al mismo tiempo. Es posible 
desplazarse a la parte superior, inferior, izquierda o derecha de las imágenes.

Pan Step Setup (Configuración de pasos de desplazamiento): Muestra el 
cuadro de diálogo Configuración de pasos de desplazamiento, que permite 
especificar el número deseado de píxeles (5, 10, 15, 25, 50 o 100) que una 
imagen se mueve al usar los comandos de desplazamiento.

Layout (Diseño): Permite cambiar entre los modos de diseño Classic 
(Clásico) y Enhanced (Mejorado).

Quick Start (Inicio rápido) permite abrir un menú con las funciones de usuario 
y los iconos de trabajo más utilizados.

Menú Capture (Captura) El menú Capture (Captura) presenta las siguientes opciones:

Start (Iniciar): activa el escáner e inicia el transporte. Método abreviado del 
teclado: F7.

Stop (Detener): despeja y detiene el transporte, y desactiva el escáner. 
Método abreviado del teclado: F6.

Page Setup List (Lista de configuraciones de página): Muestra el cuadro de 
diálogo Lista de configuraciones de página, que permite seleccionar una de 
las configuraciones de página definidas. Método abreviado del teclado: F2.

Los modos de captura permiten elegir una de las configuraciones de 
digitalización de un lote que figuran debajo.

• Two-Sided (A dos caras): Digitaliza el anverso y el reverso del documento.

• One-Sided Front (A una cara anverso): Digitaliza el anverso de una 
página.

• One-Sided Back (A una cara reverso): Digitaliza el reverso de una página.

Select Scanner (Seleccionar escáner): Muestra el cuadro de diálogo 
Configuración de la estación de trabajo, que le permite seleccionar el escáner 
que desea utilizar.

Manual Import Images (Importar imágenes de forma manual): Permite 
importar archivos de imagen creados en otra fuente (por ejemplo, un escáner 
de planos de ingeniería) en el documento que se muestra actualmente en el 
software Capture Pro. 

Al seleccionar Manual Import Images (Importar imágenes de forma manual), 
aparece el cuadro de diálogo Abrir. Desplácese hasta el directorio desde el 
que desee importar imágenes y seleccione los archivos de imagen. Se 
pueden importar archivos de imagen BMP, JPEG, PDF, TIFF, IOCA, MODCA, 
GIF, CMP y PNG. Las imágenes que seleccionó para importar se insertarán 
inmediatamente antes de la imagen que se haya seleccionado en el 
documento que se muestra actualmente. Si no hay ninguna imagen 
seleccionada, las imágenes importadas se añadirán al final del documento 
actual.

Tanto los archivos TIFF de una sola página como los de varias páginas son 
compatibles. Al importar un archivo TIFF de varias páginas, cada imagen del 
archivo se importará al documento como una imagen separada.

Se puede seleccionar más de un archivo de imagen para importarlo. Si se ha 
seleccionado más de un archivo de imagen, las imágenes se importarán en 
orden alfabético/numérico de acuerdo con el nombre de archivo de la imagen.
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View Pending Auto-Import Tasks (Ver tareas de importación automática 
pendientes): Muestra una tabla de todos los trabajos de importación 
automática que se han enviado a Capture Pro mediante el uso de la API 
(interfaz de programación de aplicaciones) de importación automática, pero 
que no se han completado todavía. 

Auto Import Setup (Configuración de importación automática): Muestra el 
cuadro de diálogo Configuración de importación automática, que permite 
configurar las “carpetas de inspección” de importación automática. Puede 
identificar las carpetas de inspección y asignarles nombres descriptivos 
mediante el cuadro de diálogo Configuración de importación automática. 
Asimismo, puede identificar directorios para el archivo y la administración de 
errores, asignar niveles de umbral de errores, especificar reglas de separación 
de lotes de importación automática e intervalos de tiempo de espera. Consulte 
la Guía del administrador del software Kodak Capture Pro para obtener más 
información.

Set Image Address (Establecer dirección de imagen): Muestra el cuadro de 
diálogo Dirección de imagen, que permite modificar la configuración de 
dirección de imagen del lote. Esta opción solo se activa si su escáner admite 
la dirección de imagen.

Set Counter (Establecer contador): Muestra el cuadro de diálogo Establecer 
contador, que permite restablecer el valor del contador secuencial asignado 
(y opcionalmente impreso) a la siguiente página digitalizada. Esta opción sólo 
se activa si su escáner dispone de un contador.

Menú Document 
(Documento)

El menú Document (Documento) presenta las siguientes opciones:

New (Nuevo): Crea un nuevo documento con un número de documento igual 
al número de documento anterior más el número 1. Método abreviado del 
teclado: Ctrl + Entrar.

NOTA: En algunos escáneres, al seleccionar New (Nuevo), también se activa 
el escáner y se inicia su transporte/alimentador o cama plana.

Attach Page (Agregar página): Permite digitalizar imágenes adicionales 
y agregarlas como páginas a un documento actual. Método abreviado del 
teclado: F4.

Insert Pages (Insertar páginas): Inserta páginas adicionales en un documento 
digitalizado. Método abreviado del teclado: tecla Insert.

NOTA: Si la dirección de imagen y la detección de parche están establecidas, 
Insert Pages (Insertar páginas) no provocará la separación del 
documento cuando se detecte un parche de documento. 

Rescan Pages (Volver a escanear páginas): Inicia el escáner y reemplaza las 
páginas seleccionadas del documento con las páginas escaneadas más 
recientes. Método abreviado del teclado: R.

Split Document (Dividir documento): Divide el documento actual en dos 
a partir de la página seleccionada.

Merge into Previous (Combinar con anterior): Coloca el documento que se 
está digitalizando en el documento anterior.

Delete (Eliminar): Elimina el documento que está abierto. Método abreviado 
del teclado: F8.

Delete Range (Eliminar intervalo): Muestra el cuadro de diálogo Eliminar los 
documentos en el intervalo, lo que permite eliminar un intervalo de 
documentos del lote.
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Delete to End of Document (Eliminar hasta el final del documento): Elimina 
la imagen seleccionada y todas las imágenes siguientes de un documento. 
Este comando elimina imágenes de la unidad de disco duro. Esta función no 
se puede deshacer.

Go to Document (Ir a documento): Permite ir al primer o último documento 
del lote, así como ir al documento anterior, posterior o seleccionar un número 
de documento para ir a un documento específico del lote.

Go to Image (Ir a imagen): Abre el cuadro de diálogo Ir a imagen, que le 
permite navegar a una específica del documento actual. Método abreviado del 
teclado: I.

Menú Edit (Editar) El menú Edit (Editar) presenta las siguientes opciones:

Undo (Deshacer): Invierte un nivel de la última acción. Si no es posible 
deshacer una acción se mostrará un mensaje. Método abreviado del teclado: 
Ctrl + Z.

Copy (Copiar): Copia una imagen seleccionada para pegarla en otra 
ubicación. Método abreviado del teclado: Ctrl + C.

Copy Image Area (Copiar área de imagen): Después de usar Draw Region 
(Dibujar región) para crear una región en la imagen, esta opción permite 
copiar esta región en otro sitio. Método abreviado del teclado: Ctrl + I.

Copy Image to Job Setup (Copiar imagen a configuración del trabajo): 
Muestra el cuadro de diálogo Copiar imagen a configuración del trabajo, lo 
que permite importar imágenes a la ventana Código de barras o a la ventana 
OCR para crear zonas de código de barras o de OCR.

Select All (Seleccionar todo): Selecciona todas las imágenes del lote actual. 
Método abreviado del teclado: Ctrl + A.

Select Document (Seleccionar documento): Selecciona todas las imágenes 
del documento actual.

Select Filtered (Seleccionar filtradas): Selecciona todas las imágenes con los 
parámetros filtrados que se escogieron.

Deselect All (Anular selección de todo): Cancela la selección de todas las 
imágenes. Método abreviado del teclado: Ctrl + D.

Select Flagged (Seleccionar marcadas): Selecciona todas las imágenes que 
se han marcado. Método abreviado del teclado: Ctrl + F.

Delete (Eliminar): Elimina las imágenes seleccionadas del lote. Método 
abreviado del teclado: Supr.
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Menú Tools 
(Herramientas)

El menú Tools (Herramientas) contiene las opciones siguientes:

Selector (Selector): Muestra la herramienta de puntero, que permite 
seleccionar imágenes. También puede seleccionar imágenes con la 
herramienta Magnify (Aumentar). Consulte Magnify (Aumentar) 
a continuación. Método abreviado del teclado: S.

Selection Mode (Modo de selección): Seleccione Image, Page o Page Side 
(Imagen, Página o Cara de la página). 

• Si selecciona Image (Imagen), puede hacer clic en una imagen del Visor de 
imágenes y solo se seleccionará la imagen.

• Si selecciona Page (Página), puede hacer clic sobre la imagen y se 
seleccionará toda la página, el anverso y reverso, en blanco y negro y en 
color/escala de grises.

• Si está digitalizando varias imágenes por una cara (digitalización dual-
stream), cuando seleccione Page Side (Cara de la página) y haga clic en 
una imagen del anverso, se seleccionarán las imágenes de todos los 
anversos. Si hace clic en una imagen del reverso, se seleccionarán las 
imágenes de todos los reversos.

Magnify (Aumentar): Amplía una parte de una imagen. Al seleccionar Magnify 
(Aumentar), se mostrará la herramienta para aumentar. El área en la que sitúe la 
herramienta para aumentar se ampliará. Mantenga presionado el botón primario 
del mouse para aumentar la imagen. Haga clic con el botón primario del mouse 
para seleccionar la imagen. Método abreviado del teclado: M.

Pan (Desplazar): Permite mover la imagen alrededor del panel del visor de 
imágenes cuando la imagen es más grande que el panel. Método abreviado 
del teclado: P. Haga clic con el botón primario del mouse para seleccionar la 
imagen.

Draw Region (Dibujar región): Permite dibujar un rectángulo alrededor de una 
parte de una imagen, poner en blanco el área dentro del rectángulo mediante 
la opción Blank (En blanco), recortar la imagen para ajustarla al tamaño del 
rectángulo con la opción Crop (Recortar), o copiar utilizando Edit > Copy 
Image Area (Editar > Copiar área de imagen).

Magnification Ratio (Factor de aumento): Muestra el cuadro de diálogo 
Configuración de factor de aumento, que permite seleccionar el factor de 
aumento deseado (100 %, 150 %, 200 %, 250 % o 300 %).

Para ampliar una imagen actual en el visor de imágenes o en el visor de 
miniaturas:

1. Seleccione Tools > Magnify (Herramientas > Aumentar).

2. Haga clic en una imagen y, a continuación, sujete y arrastre la herramienta 
de aumento sobre ella.

Rotate (Girar): Gira manualmente la imagen seleccionada 90, 180 o 270 
grados hacia la derecha. El software Capture Pro le permite girar 
automáticamente las imágenes a medida que se digitalizan o girarlas 
manualmente después de digitalizadas.

Intelligent QC: Inicia la herramienta Intelligent QC. Todas las imágenes 
seleccionadas estarán disponibles para su revisión y procesamiento. Si no se 
ha seleccionado ninguna imagen, estarán disponibles todas las imágenes 
marcadas. Otra manera de iniciar la herramienta Intelligent QC consiste en 
hacer clic con el botón secundario en una imagen del visor de imágenes o del 
explorador de lotes y, a continuación, seleccionar Intelligent QC en la lista. 
Para obtener más información, consulte “Cuadro de diálogo de la herramienta 
Intelligent QC” en la página 28.
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Opciones de la herramienta Marcar: Permite marcar una imagen que sea 
necesario volver a digitalizar o ajustar de algún modo (por ejemplo, que haya 
que ajustar los valores de contraste para lograr una mayor calidad de la 
imagen). Método abreviado del teclado: C.

• Flag Tool (Herramienta Marcar): Permite marcar una página, una imagen 
o el anverso y el reverso de una imagen.

• Flag All Selected (Marcar todas las seleccionadas): Marca todas las 
imágenes seleccionadas en el lote para volver a digitalizarlas.

• Flag Document (Marcar documento): Marca todas las imágenes del 
documento seleccionado.

• Flag Filtered (Filtrado por marca): Permite aplicar un filtro a las imágenes 
que se muestran en el visor de imágenes. Cuando haya seleccionado el 
visor al que desea aplicar el filtro, podrá seleccionar Front Side o Back 
Side y Black and White, Grayscale o Color (Anverso o Reverso; y Blanco 
y negro, Escala de grises o Color) para las imágenes.

• Unflag All Selected (Desmarcar todas las seleccionadas): Quita las 
marcas de las imágenes seleccionadas actualmente.

• Unflag All (Desmarcar todas): Quita cualquiera de las imágenes marcadas 
anteriormente del lote actual. 

Split Document (Dividir documento): Divide un documento en dos 
documentos.

Crop (Recortar): Permite recortar el área situada al exterior del rectángulo que 
haya creado mediante la opción Dibujar región. Al seleccionar esta opción, se 
mostrará un cuadro de confirmación. Método abreviado del teclado: Ctrl + R. 

Blank (En blanco): Permite poner en blanco el área dentro del rectángulo 
creado mediante la opción Dibujar región. Al seleccionar esta opción, se 
mostrará un cuadro de confirmación. Método abreviado del teclado: Ctrl + B. 

Mark As Blank (Marcar como imagen en blanco): permite marcar las 
imágenes como imágenes en blanco cuando se selecciona esta opción desde 
el menú Herramientas o haciendo clic con el botón secundario en una imagen 
seleccionada. Una imagen marcada como imagen en blanco se identifica con 
un borde azul oscuro. Si se selecciona esta opción en una imagen ya 
marcada, dicha imagen se desmarcará. Esta opción solo está disponible si 
está habilitada la opción “Keep blank images” (Mantener imágenes en blanco) 
en la sección “Auto Delete” (Eliminación automática) para la configuración de 
página seleccionada actualmente.

Cuadro de diálogo de la 
herramienta Intelligent QC

Para iniciar la herramienta Intelligent QC, seleccione dicha herramienta en la 
barra de herramientas Editar. Todas las imágenes seleccionadas estarán 
disponibles para su revisión y procesamiento. Si no se ha seleccionado 
ninguna imagen, estarán disponibles todas las imágenes marcadas. Otra 
manera de iniciar la herramienta Intelligent QC consiste en hacer clic con el 
botón secundario en una imagen del visor de imágenes o del explorador de 
lotes y, a continuación, seleccionar Intelligent QC en la lista.
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La herramienta Intelligent QC no está disponible mientras digitaliza o vuelve a 
digitalizar, o cuando la importación automática supervisa activamente la 
carpeta activa en busca de archivos de imagen.

Cuando accede a la herramienta Intelligent QC, la primera imagen se muestra 
en el panel de imágenes izquierdo. El panel de imágenes izquierdo muestra la 
imagen tal como se ve, sin ningún tipo de procesamiento adicional.

El panel de imágenes derecho muestra cómo se ve la imagen tras el 
procesamiento.

Puede editar la imagen haciendo clic en una o varias herramientas de 
procesamiento de imágenes situadas entre los paneles de imagen. Para 
deshacer una función de procesamiento de imágenes concreto, basta con 
hacer clic de nuevo en la herramienta para cancelar la selección.

Algunas herramientas de procesamiento de imágenes ofrecen controles 
adicionales para ajustar la apariencia de la imagen. Por ejemplo, la 
herramienta Binarización proporciona un control del contraste. El ajuste del 
contraste permite ver textos muy claros a la vez que se mantiene el ruido de 
fondo en un nivel aceptable.

Apply settings to next image (Aplicar configuración a la siguiente imagen): 
Si la opción está seleccionada, las herramientas de procesamiento de imagen 
seleccionadas en ese momento y la configuración de estas herramientas se 
aplicarán a la siguiente imagen, cuando corresponda. Si la opción 
Binarización se encuentra seleccionada y la imagen siguiente es en blanco 
y negro, no se aplicará la binarización. Sin embargo, si la opción Hole Fill 
(Llenar orificios) también se encuentra habilitada, se aplicará a la imagen en 
blanco y negro. 

Apply To All (Aplicar a todo): Aplicará las herramientas de procesamiento de 
imagen seleccionadas a todas las imágenes seleccionadas con la 
herramienta Intelligent QC.
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Next (Siguiente): Esta opción está disponible si hay imágenes adicionales 
para revisar. Si hace clic en Next (Siguiente), se guardará la imagen actual tal 
como se muestra en el panel de imágenes derecho. Si activa la casilla de 
verificación Aplicar a siguiente, las herramientas de procesamiento de 
imagen seleccionadas en ese momento se aplicarán a la siguiente imagen. 
La imagen antes de procesar se mostrará en el panel de imágenes izquierdo; 
mientras que la imagen procesada se mostrará en el panel de imágenes 
derecho. 

Back (Atrás): Muestra la imagen que se ha visualizado anteriormente. 
Se desactivarán todas las selecciones de herramienta y se desactivará la 
casilla de verificación Aplicar a siguiente. La imagen se mostrará tal como se 
mostraba cuando se seleccionó el botón Next (Siguiente).

View B&W y View Grayscale/Color (Ver en blanco y negro y Ver en escala 
de grises/color): Cuando hay una imagen en escala de grises/color y una 
imagen en blanco y negro asociada (salida simultánea), la imagen en blanco 
y negro se muestra en el panel de imágenes izquierdo. Para ver la imagen 
en escala de grises o en color, haga clic en el botón Ver en escala de grises/
color.
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Menú Index (Índice) El menú Index (Índice) presenta las siguientes opciones:

Edit Index Fields (Editar campos de índice): Ofrece acceso a los campos de 
índice a nivel de lote y documento. Método abreviado del teclado: E.

NOTA: En el caso de las licencias de grupo A y B, debe haber un escáner 
físico conectado para editar campos de índice. Si necesita 
características de indexación sin un escáner conectado, puede 
adquirir una licencia de indexación.

Previous Document (Documento anterior): Muestra información de índice del 
documento anterior. Método abreviado del teclado: F9.

Next Document (Documento siguiente): Muestra información de índice del 
siguiente documento. Método abreviado del teclado: F10.

Next Invalid (Siguiente no válido): Muestra información de índice del siguiente 
documento que tenga un índice no válido. Método abreviado del teclado: F11.

Index1 (Índice1): Permite indicar que el lote está listo para la indexación.

Index2 (Índice2): Permite indicar que el lote está listo para la segunda entrada 
de índice cuando se utiliza la entrada doble de datos.

NOTA: Cuando utiliza la entrada doble de datos y usted, como operador de 
captura, también introduce el primer valor de índice, tendrá que 
seleccionar primero Index1 (Índice1) y, a continuación, seleccionar 
Index2 (Índice2) cuando el lote esté listo para la segunda entrada de 
valores de índice. Para obtener más información sobre la entrada de 
datos doble, consulte “Cómo usar el ingreso doble de datos” en la 
página 32.

Define Enter Key Behavior (Definir comportamiento de tecla Entrar): Permite 
asignar la acción que desea que realice el software cuando presione la tecla 
Entrar. Las opciones disponibles son Ir al siguiente documento, Ir al 
siguiente documento no válido o Guardar y salir de la indexación.

Zoom Zones (Zonas de ampliación): Permite trazar un rectángulo alrededor 
de una porción de la imagen que desee ampliar para visualizarla al editar los 
campos de índice. Este valor de acercamiento se guarda según el campo de 
índice. En consecuencia, puede definir una zona de ampliación para cada 
campo de índice, y la visualización de la imagen se ampliará a la parte 
correspondiente al editar el campo.

Drag-and-Drop OCR (Arrastrar y soltar OCR): Permite completar un campo 
de índice dibujando una región en la imagen. El OCR se realiza desde dentro 
de la región y el valor se pone directamente en ese campo de índice. Después 
de seleccionar la herramienta, dibuje un rectángulo alrededor de los datos de 
índice que vaya a capturar. 

NOTA: Para crear correctamente caracteres especiales específicos de 
determinados idiomas (por ejemplo, « o ¸) o caracteres de código 
MICR con la función OCR de reconocimiento óptico de caracteres, 
seleccione el idioma o la fuente MICR correspondiente de la lista 
desplegable.

One Click OCR (OCR con un clic): Permite hacer clic en una palabra o en un 
valor para establecer el campo de índice seleccionado. Para anexar varias 
palabras o valores, presione la tecla Ctrl y haga clic en las palabras o valores 
adicionales.

OCR Language (Idioma de OCR): Permite configurar el idioma que se 
utilizará para la función de OCR. 
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Save & Exit Indexing (Guardar y salir de la indexación): Sale de la indexación 
y guarda los cambios que haya aplicado al lote. Método abreviado del teclado: 
F12.

Cancel & Exit Indexing (Cancelar y salir de la indexación): Sale de la 
indexación sin guardar los cambios que se hayan aplicado al lote. Método 
abreviado del teclado: Esc.

Uso de la búsqueda en la base 
de datos

Después de realizar la digitalización y de que el usuario acceda al modo 
Índice (Índice > Editar campos de índice), la búsqueda siempre se realizará 
en un documento cada vez que se navegue hasta el documento mientras se 
esté en modo de indexación.

Si el campo de índice que se está utilizando para la búsqueda ya tiene un 
valor (por ejemplo, de un código de barras o de una zona de OCR), la 
búsqueda de un documento se realizará automáticamente cuando se navegue 
hasta el documento.

Si los datos se están introduciendo manualmente en el campo de índice, la 
búsqueda se realizará cuando el usuario abandone el campo de índice. Si se 
usa la tecla Tab para salir del campo de índice que se acaba de introducir, los 
resultados de completar otros campos de índice se mostrarán para su 
verificación. Si se utiliza la tecla Intro o alguna de las demás teclas de función 
del modo de indexación (por ejemplo, F9, F10 o F11) para navegar hasta otro 
documento, se realizará la búsqueda y se completarán el resto de campos de 
índice. Sin embargo, no verá los resultados de la búsqueda, ya que el 
documento ha dejado de visualizarse en modo de indexación.

Si el campo de búsqueda de índice se rellena utilizando OCR mediante la 
técnica de arrastrar y soltar, la búsqueda se realizará inmediatamente y se 
mostrarán los resultados de completar el resto de campos de índice para que 
los verifique.

Si el valor que se utiliza para la búsqueda solo se conoce parcialmente, el 
carácter de asterisco (*) puede utilizarse para reemplazar los caracteres 
desconocidos. El carácter de asterisco debe ser el último carácter. Por 
ejemplo, si el valor de búsqueda es un número de teléfono, pero solo es 
posible leer los primeros cuatro dígitos, puede indicarse el valor “557-3*”. 
Todos los números telefónicos que comiencen con “557-3xx…” se 
recuperarán de la base de datos y usted podrá seleccionar el valor correcto.

Cuando una búsqueda se basa en dos valores y solo conoce un valor, el 
carácter de asterisco puede utilizarse en lugar del valor desconocido. Por 
ejemplo, la búsqueda se basa en el apellido Y en el nombre, y se busca la 
dirección. Si solo conoce el apellido, lo indica en el campo índice “Apellido”, 
y el carácter de asterisco se ingresa en el campo índice “Nombre”. Si solo se 
halla un registro para el apellido indicado, se completarán el nombre y la 
dirección. Si se hallan varios registros para el apellido, el cuadro de diálogo 
Múltiples resultados se visualizará, y se podrá seleccionar la entrada 
correspondiente. 

Cómo usar el ingreso doble 
de datos 

Los trabajos que tienen uno o más lotes o campos de índice de documentos 
configurados para la entrada doble de datos se utilizan del mismo modo que 
otros trabajos para digitalizar documentos.

Cuando se completa la digitalización del documento y el lote está listo para la 
indexación, el operador selecciona Index > Index1 (Índice > Índice1). Esto 
cambia el estado del lote de Available (Disponible) a Index1 (Índice1), lo que 
indica que el lote está listo para la entrada del primer conjunto de valores de 
índice.
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Cuando el operador del primer índice introduzca los valores de índice de todos 
los documentos, seleccionará Index > Index2 (Índice > Índice2). Esto cambia 
el estado del lote de Index1 (Índice1) a Index2 (Índice2), lo que indica que el 
lote está ahora listo para la entrada del segundo conjunto de valores de 
índice.

El operador del segundo índice no verá los valores introducidos por el 
operador del primer índice.

Si el valor introducido por el operador del segundo índice coincide con el 
primer valor, no será necesaria ninguna acción y continuará la indexación.

Si el primer y segundo valor no coinciden, aparecerá el cuadro de diálogo 
Resolución de entrada y el operador seleccionará la entrada correcta.

NOTAS:

• Si el operador de digitalización también introduce el primer conjunto de 
valores de índice, tendrá que seleccionar Index > Index1 (Índice > Índice1) 
inmediatamente después de seleccionar Index > Index2 (Índice > Índice2) 
cuando se complete la digitalización y la operación del primer índice.

• La comparación de los valores de Índice1 e Índice2 distingue entre 
mayúsculas y minúsculas. Por ejemplo “MAYÚSCULAS” no coincide con 
“Mayúsculas”. Los ceros iniciales también son importantes. Por ejemplo, el 
valor 123 no coincide con 0123.

• Antes de guardar el valor, se eliminarán los espacios finales e iniciales de 
todos los campos de índice de entrada doble. 

Por ejemplo, si se introduce el valor “    Envío     ”, el valor se guarda como 
“Envío”. Esto significa que, si el Índice1 se introduce como “     Envío” 
e Índice2 se introduce como “Envío     ”, los valores coincidirán.
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Resolución de entrada El cuadro de diálogo Entry Resolution (Resolución de entrada) se muestra 
cuando el valor del segundo índice coincide con el valor del primer índice.

El operador del índice tiene las siguientes opciones:

• Elegir la entrada realizada por el operador del primer índice al seleccionar 
Entry1 (Entrada1).

• Elegir su entrada al seleccionar Entry2 (Entrada2).

• Introducir un valor nuevo en el campo New Entry (Nueva entrada) si 
ninguna entrada es correcta.

• Cancelar y cerrar el cuadro de diálogo Entry Resolution (Resolución de 
entrada) si no desea realizar ninguna elección. Si decide no resolver el 
valor de índice que no coincide en uno o más campos de índice 
obligatorios, aparecerá el siguiente mensaje si se intenta generar el lote: 
Uno o varios campos de índice requieren entrada doble. No puede 
generar el lote en este momento. ¿Desea ingresar al modo Índice? 

Si ninguno de los campos de entrada doble es obligatorio, el cuadro de 
diálogo Entry Resolution (Resolución de entrada) se mostrará durante la 
generación. Todos los campos de índice de entrada doble con entradas no 
coincidentes se deben resolver antes de la generación.

NOTAS:

• Si un campo de entrada doble no es un campo obligatorio, una o ambas 
entradas de índice se pueden dejar en blanco y no se mostrará el cuadro de 
diálogo Entry Resolution (Resolución de entrada); no se producirán errores 
al generar.

• Si se introducen ambos valores de entrada doble y no coinciden, el 
operador deber realizar una selección en el cuadro de diálogo Entry 
Resolution (Resolución de entrada) antes de la generación.

• Un campo de índice habilitado para entrada doble no se puede utilizar para 
realizar una búsqueda en la base de datos ni puede ser un campo 
verificado o rellenado por una búsqueda en la base de datos.
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Menú Help (Ayuda) El menú Help (Ayuda) presenta las siguientes opciones:

Help (Ayuda): Muestra la ayuda en línea del software Capture Pro. Método 
abreviado del teclado: F1.

Capture Pro Getting Started Guide (Guía de inicio rápido de Capture Pro): 
Muestra la Guía de inicio rápido, que ofrece una serie de procedimientos 
básicos y sencillos para empezar a utilizar el software Capture Pro de 
inmediato.

Send Error Report (Enviar informe de errores): Muestra el cuadro de diálogo 
Enviar informe de errores, que le permite introducir un mensaje con la 
descripción del problema y enviarlo a Kodak Alaris.

License Manager (Administrador de licencias): Proporciona acceso al 
Administrador de licencias, la forma más sencilla de obtener una licencia para 
una estación de trabajo que ejecute el software Capture Pro y no disponga de 
acceso a Internet.

Register (Registro): Permite registrar el software Capture Pro.

Capture Pro Online (Capture Pro en línea): Muestra la ayuda en línea del 
software Capture Pro.

About Capture Pro (Acerca de Capture Pro): Muestra el cuadro de diálogo 
sobre el software Capture Pro, que proporciona información acerca de la 
versión actual del software. Utilice este cuadro para ver la siguiente 
información:

• Copyright
• Extensión de archivos
• Ruta de archivos
• Número de serie del software
• Número de versión del software

Este cuadro de diálogo también permite acceder a Información del sistema, 
que abre la ventana Información de archivos. Esta ventana proporciona 
información sobre archivos independientes dentro del software Capture Pro. 
La ventana Información de archivos es de solo lectura.

• Nombre de archivo
• Tamaño de archivo
• Fecha de creación
• Número de versión
• Descripción

NOTA: Haga clic en la “X” en la esquina superior derecha para cerrar la 
ventana Información de archivos.
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Barras de 
herramientas

Barra de herramientas 
Capture (Captura)

La barra de herramientas Capture (Captura) presenta los siguientes 
comandos:

Barra de herramientas 
Batch (Lote)

La barra de herramientas Batch (Lote) presenta los siguientes comandos:

Barra de herramientas 
Document (Documento)

La barra de herramientas Document (Documento) presenta los siguientes 
comandos:

Start (Iniciar): Comienza a digitalizar imágenes en el escáner.

Stop Scan (Detener digitalización): Deja de digitalizar imágenes.

Page Setup Name (Nombre de configuración de página): En la lista 
desplegable, seleccione el nombre de configuración de página que más se 
ajuste al trabajo que está digitalizando.

Page Setup (Configuración de página): Muestra el cuadro de 
diálogo Configuración de página, que permite configurar los 
parámetros de digitalización.

Sides to Capture (Caras para capturar): Permite seleccionar 
Two-Sided, One-Sided Front o One-Sided Back (A dos caras, 
A una cara anverso o A una cara reverso).

NOTA: Es posible que no pueda utilizar esta opción con algunos 
escáneres que no son de Kodak. 

New Batch (Nuevo lote): Muestra el cuadro de diálogo Nuevo 
lote, que le permite crear un nuevo lote.

Open Batch (Abrir lote): Muestra el cuadro de diálogo 
Administrador de lotes, que le permite abrir un lote ya creado.

Close Batch (Cerrar lote): Cierra el lote abierto actualmente.

Output Batch (Generar lote): Comienza a generar todas las 
imágenes del lote actual.

New Document (Nuevo documento): Permite agregar un 
documento nuevo.

Insert Pages (Insertar páginas): Inserta páginas adicionales en 
un documento digitalizado. Resalte la primer imagen de una 
página y se activará el icono. Ponga las páginas adicionales en 
el escáner y haga clic en este icono.

Rescan Pages (Volver a digitalizar páginas): Repite la 
digitalización de partes seleccionadas del documento. Resalte la 
página o páginas que desee volver a digitalizar, ponga los 
originales en el escáner y haga clic en este icono.
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Barra de herramientas 
View (Ver)

La barra de herramientas View (Ver) incluye los comandos siguientes:

Split Document (Dividir documento): Divide un documento en 
dos a partir de la página seleccionada. Para dividir un 
documento, haga clic en Split document (Dividir documento). 
En el visor de imágenes, haga clic en la página por la que se 
dividirá para crear un nuevo documento. 

Selector (Selector): Muestra la herramienta de puntero, que 
permite seleccionar imágenes.

Selection Mode (Modo de selección): Seleccione Image, Page 
o Page Side (Imagen, Página o Cara de la página). 

• Si selecciona Image (Imagen), puede hacer clic en una 
imagen del visor de imágenes y solo se seleccionará la 
imagen.

• Si selecciona Page (Página), puede hacer clic sobre la 
imagen y se seleccionará toda la página, el anverso 
y reverso, en blanco y negro y en color/escala de grises.

• Si está digitalizando varias imágenes por una cara 
(digitalización dual-stream), cuando seleccione Page Side 
(Cara de la página) y haga clic en una imagen del anverso, se 
seleccionarán las imágenes de todos los anversos. Si hace 
clic en una imagen del reverso, se seleccionarán las 
imágenes de todos los reversos.

Magnify (Aumentar): Permite ampliar una parte de una imagen. 
Al seleccionar Magnify (Aumentar), se mostrará la herramienta 
para aumentar. El área en la que sitúe la herramienta se 
ampliará. Debe hacer clic y mantener presionado el botón del 
mouse sobre la imagen.

Pan (Desplazar): Permite mover la imagen alrededor de la 
ventana cuando la imagen es más grande que la ventana.

Image Viewer Display (Visualización del visor de imágenes): 
Permite utilizar la flecha hacia abajo para visualizar 1, 2, 4 u 8 
imágenes, o usar la opción Customize (Personalizar) para 
personalizar el diseño. Al seleccionar Customize 
(Personalizar), se muestra el cuadro de diálogo Configuración 
de diseño personalizado, que permite introducir el número de 
filas y columnas que desea que aparezcan en el visor de 
imágenes.

Zoom In (Acercar): Agranda todas las imágenes del visor de 
imágenes.

Zoom Out (Alejar): Achica todas las imágenes del visor de 
imágenes.

 

Quick Start (Inicio rápido): Abre la pantalla de inicio rápido, que 
contiene paneles de trabajo para comenzar un trabajo de 
impresión.
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Barra de herramientas 
Navigation (Navegación)

La barra de herramientas Navigation (Navegación) incluye los comandos 
siguientes:

Barra de herramientas 
Flag (Marcar)

La barra de herramientas Flag (Marcar) presenta los siguientes comandos:

Barra de herramientas 
Edit (Editar)

La barra de herramientas Edit (Editar) presenta los siguientes comandos:

First Document (Primer documento): Muestra el primer 
documento del lote en el visor de imágenes.

Last Document (Último documento): Muestra el último 
documento del lote en el visor de imágenes.

Previous Document (Documento anterior): Muestra el 
documento anterior del lote en el visor de imágenes.

Next Document (Documento siguiente): Muestra el siguiente 
documento del lote en el visor de imágenes.

Flag Tool (Herramienta para marcar): Permite marcar una 
página o imagen. Por ejemplo, puede querer identificar 
permanentemente imágenes que es necesario volver 
a digitalizar.

Flag All Selected (Marcar todas las seleccionadas): Marca 
todas las imágenes seleccionadas del lote.

Flag Filtered (Filtrado por marca): Permite marcar las imágenes 
que se muestran actualmente en el visor de imágenes o el visor 
de miniaturas. 

Unflag All (Desmarcar todas): Quita las marcas de cualquiera 
de las imágenes del lote actual marcadas anteriormente.

Edit Index Fields (Editar campos de índice): ofrece acceso 
a los campos de índice a nivel de lote y documento.

Rotate 90 (Girar 90º): Gira las imágenes seleccionadas 
90 grados hacia la derecha.

Rotate 180 (Girar 90º): Gira las imágenes seleccionadas 
180 grados hacia la derecha.

Rotate 270 (Girar 270º): Gira las imágenes seleccionadas 
270 grados hacia la derecha.

Intelligent QC: Inicia la herramienta Intelligent QC. Todas las 
imágenes seleccionadas estarán disponibles para su revisión 
y procesamiento. Si no se ha seleccionado ninguna imagen, 
estarán disponibles todas las imágenes marcadas. Otra manera 
de iniciar la herramienta Intelligent QC consiste en hacer clic 
con el botón secundario en una imagen del visor de imágenes 
o del explorador de lotes y, a continuación, seleccionar 
Intelligent QC en la lista.

La herramienta Draw Region (Dibujar región) Permite dibujar 
un rectángulo alrededor de una parte de una imagen, eliminar 
el área dentro del rectángulo mediante la opción Blank 
(En blanco) o recortar la imagen para ajustarla al tamaño del 
rectángulo con la opción Crop (Recortar).
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Barra de herramientas 
Index (Índice)

La barra de herramientas Index (Índice) presenta los siguientes comandos:

Crop (Recortar): Permite eliminar el área situada al exterior del 
rectángulo que haya creado mediante la opción Dibujar región. 

Blank (En blanco): Permite poner en blanco el área dentro del 
rectángulo creado mediante la opción Dibujar región. Al hacer 
clic en este icono, aparecerá un cuadro de confirmación. 

Print (Imprimir): Muestra elcuadro de diálogo Configuración de 
impresión, que le permite imprimir un documento completo o 
imagen específica dentro de un documento.

Save as PDF (Guardar como PDF): Muestra el cuadro de 
diálogo Guardar como PDF, que permite guardar imágenes 
individuales o documentos completos como un archivo PDF con 
o sin capacidad de búsqueda.

Delete Selected (Eliminar imagen seleccionada): Elimina una 
o más imágenes seleccionadas en un documento. Por ejemplo, 
se pueden eliminar las imágenes en blanco de un documento 
a dos caras. Las imágenes restantes se numeran de nuevo una 
vez eliminadas las imágenes seleccionadas. Al hacer clic en 
este icono, aparecerá un cuadro de confirmación.

Undo (Deshacer): Revierte las tareas de recortar, poner en 
blanco o girar más recientes de una o varias imágenes. La 
opción Undo (Deshacer) no revierte la eliminación.

Previous document (Documento anterior):  Permite 
desplazarse al número de documento anterior que contenga 
imágenes.

Next document (Documento siguiente): Permite desplazarse al 
número de documento siguiente que contenga imágenes.

Next Invalid (Siguiente no válido): Permite desplazarse al 
documento siguiente que tenga un índice no válido.

Zoom Zones (Zonas de ampliación): Aumenta la visualización 
de los datos de índice del campo actual capturados, lo que 
permite ver más claramente caracteres específicos del idioma 
o aquellos más difíciles de visualizar.

Drag-and-Drop OCR (OCR al arrastrar y soltar): Permite 
arrastrar y soltar la indexación mediante reconocimiento óptico 
de caracteres (OCR) sin tener que introducir el valor de índice. 
Después de seleccionar la herramienta, dibuje un rectángulo 
alrededor de los datos de índice que vaya a capturar.

Este icono le permite hacer clic en una palabra o valor para 
establecer el campo de índice seleccionado. Para anexar varias 
palabras o valores, presione la tecla Ctrl y haga clic en las 
palabras o valores adicionales.

OCR Language (Idioma de OCR): Permite seleccionar un 
idioma de OCR en la lista desplegable. 

Save & Exit Indexing (Guardar y salir de la indexación): 
Guarda los cambios en el lote actual y cierra la ventana Índice. 

Cancel & Exit Indexing (Cancelar y salir de la indexación): 
Cierra la ventana Índice sin guardar ningún cambio.
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Barra de herramientas 
Scanner Adjustments 
(Ajustes del escáner)

La barra de herramientas Ajustes del escáner permite cambiar las siguientes 
opciones de digitalización directamente desde la ventana principal del 
software Capture Pro:

NOTAS:

• La barra de herramientas Ajustes del escáner solo está disponible y se 
puede utilizar con escáneres Kodak.

• Cualquier modificación realizada en la configuración es temporal y no 
modificará la configuración de página seleccionada actualmente y que se 
utiliza para la digitalización.

• Cuando se realiza un cambio en uno de los valores de configuración de la 
barra de herramientas, dicho valor aparece resaltado en amarillo para 
indicar que se ha realizado una modificación.

• Si se cambia la configuración de página que se utiliza para la digitalización 
o se vuelve a seleccionar la misma configuración de página, la 
configuración de la barra de herramientas Ajustes del escáner se 
restablecerá con los valores definidos en la configuración de página.

Threshold (Umbral):  Controla la claridad y oscuridad del 
fondo de una imagen. Los valores válidos oscilan entre 
0 y 255. Hay una configuración de umbral independiente 
para el anverso y el reverso de las imágenes.

Contrast (Contraste): Realza los bordes incluidos en un 
documento. Cuanto mayor sea el nivel de contraste, más 
se realzarán los bordes de la imagen. Los valores válidos 
oscilan entre 0 y 100 o -50 y 50, según el modelo de 
escáner. Hay una configuración de contraste 
independiente para el anverso y el reverso de las 
imágenes.

iThresholding: Cuando se selecciona esta opción, el 
escáner determina de manera automática el valor de 
umbral óptimo de cada página digitalizada, mejorando así 
la productividad general de la digitalización y la calidad de 
imagen. Cuando se selecciona, la configuración de 
umbral el anverso y el reverso de las imágenes está 
atenuada y no se puede modificar.

Anverso Reverso

Anverso Reverso
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Explorador de lotes El menú Batch Explorer (Explorador de lotes) muestra todas las carpetas de 
documentos, archivos de páginas e imágenes del lote abierto en el visor de 
imágenes. Aparece automáticamente en la parte izquierda de la ventana 
principal cuando está activo el diseño ampliado.

• Puede hacer clic en un archivo de imagen del explorador de lotes y la 
imagen se mostrará en el visor de imágenes.

• También puede arrastrar una carpeta de documentos o un archivo de 
imagen o de página a una ubicación distinta del explorador de lotes.

• Asimismo, puede hacer clic con el botón secundario en un archivo de 
imagen o en una carpeta de documentos para mostrar el menú contextual 
y ver más opciones.

• Presione la tecla Ctrl junto con:

+ para expandir todos los nodos

- para contraer todos los nodos

L para crear un nuevo documento a partir de la página seleccionada

X para cortar la página o la imagen seleccionadas

V para pegar la última página o imagen cortada antes de la página 
o imagen seleccionada

- Si se cortó una página y hay una imagen seleccionada cuando se 
presiona Ctrl + V, se inserta la página antes de la página de la imagen 
seleccionada.

- Si se cortó una imagen y hay una página seleccionada cuando se 
presiona Ctrl + V, se insertará la imagen antes de la primera imagen 
de las páginas seleccionadas.



42 A-61992_es  Marzo de 2022

Visor de imágenes El área del visor de imágenes es el área en que se muestran las imágenes. 
Puede ver una, dos, cuatro u ocho imágenes a la vez, o bien personalizar el 
diseño del visor de imágenes.

La barra de título contiene el nombre del lote y el número de documento de las 
imágenes mostradas en el visor de imágenes. 

Para mover una imagen:

1. Seleccione una imagen.

2. Arrastre la imagen a la posición deseada.

Para eliminar una imagen:

1. Seleccione una imagen. 

2. Seleccione Edit > Delete (Editar > Eliminar). La imagen se eliminará del 
documento.

Para cambiar el número de imágenes que se muestran:

1. Seleccione View > Image Viewer Display (Ver > Visualización del visor 
de imágenes).

2. Seleccione 1, 2, 4, 8 o Customize (Personalizar). El visor de imágenes 
muestra el diseño seleccionado.

NOTA: Si selecciona Customize (Personalizar), se muestra el cuadro 
de diálogo de configuración de diseño personalizado, que 
permite introducir el número de filas y columnas que desea que 
aparezcan.

Menú contextual de 
imagen

Si hace clic con el botón secundario sobre una imagen en el visor de 
imágenes, se muestra un menú que ofrece las siguientes opciones:

Mark As Blank (Marcar como imagen en blanco): permite marcar las 
imágenes como imágenes en blanco cuando se selecciona esta opción desde 
el visor de imágenes o haciendo clic con el botón secundario en una imagen 
seleccionada. Esta opción solo está disponible si está habilitada la opción 
“Keep blank images” (Mantener imágenes en blanco) en la sección “Auto 
Delete” (Eliminación automática) en la configuración de página seleccionada 
actualmente. Cuando se selecciona una imagen, aparece resaltada en el visor 
de imágenes con un borde grueso de color azul oscuro.

Selection Mode (Modo de selección): Elija Image, Page o Page Side 
(Imagen, Página, o Cara de la página). 

• Si selecciona Image (Imagen), puede hacer clic en una imagen del visor de 
imágenes y solo se seleccionará la imagen.

• Si selecciona Page (Página), puede hacer clic sobre la imagen y se 
seleccionará toda la página, el anverso y reverso, en blanco y negro y en 
color/escala de grises.

• Si está digitalizando varias imágenes por una cara (digitalización dual-
stream), cuando seleccione Page Side (Cara de la página) y haga clic en 
una imagen del anverso, se seleccionarán las imágenes de todos los 
anversos. Si hace clic en una imagen del reverso, se seleccionarán las 
imágenes de todos los reversos.

Deselect All (Anular selección de todo): Cancela la selección de todas las 
imágenes en el visor de imágenes.

Delete (Eliminar): Elimina las imágenes resaltadas después de que el usuario 
confirma la acción.
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Copy (Copiar): Copia una imagen seleccionada para pegarla en otra 
ubicación.

Copy Image Area (Copiar área de imagen): Después de usar Draw Region 
(Dibujar región) para crear una región en la imagen, esta opción permite 
copiar esta región en otro sitio.

Copy Image to Job Setup (Copiar imagen a configuración del trabajo): 
Muestra el cuadro de diálogo Copiar imagen a configuración del trabajo, lo 
que permite importar imágenes a la ventana Código de barras o a la ventana 
OCR para crear zonas de código de barras o de OCR.

Rotate (Girar): Gira la imagen seleccionada 90, 180 o 270 grados hacia la 
derecha.

Intelligent QC: Inicia la herramienta Intelligent QC. Todas las imágenes 
seleccionadas estarán disponibles para su revisión y procesamiento. Si no ha 
seleccionado ninguna imagen, estarán disponibles todas las imágenes 
marcadas.

Split Document (Dividir documento): Realiza una separación manual y divide 
el documento seleccionado en dos documentos.

Merge into Previous (Fusionar en anterior): Fusiona el documento 
seleccionado con el anterior para crear un solo documento.

Zoom (Ampliar): Aumenta o reduce el tamaño en que se muestra la imagen. 

• Fit Images to window (Ajustar imagen a ventana): Ajusta cada imagen a su 
panel del visor de imágenes, independientemente de su tamaño original.

• Actual (Real): Amplía una imagen a su tamaño físico real.

• Zoom in (Acercar): Aumenta una imagen en un porcentaje fijo establecido 
en la configuración de pasos de acercamiento.

• Alejar: Reduce una imagen en un porcentaje fijo establecido en la 
configuración de pasos de ampliación.

• Zoom Step (Paso de ampliación): Accede al cuadro de diálogo Paso de 
ampliación, que permite especificar un porcentaje de 15 a 40 % en 
incrementos de 5 %.

Pan All Images to (Desplazar todas las imágenes a): Desplaza todas las 
imágenes a un sector, como Top (Superior), Bottom (Inferior), Left 
(Izquierdo), Right (Derecho) o Same (Misma posición).

Pan Step Setup (Configuración de paso de desplazamiento): Muestra el 
cuadro de diálogo Configuración de paso de desplazamiento, que le permite 
cambiar la configuración de píxeles de la herramienta Desplazar.

Hide Front (Ocultar anverso): Oculta todas las imágenes de anverso del lote. 

Hide Back (Ocultar reverso): Oculta todas las imágenes de reverso del lote.

Hide Black and White (Ocultar blanco y negro): Oculta todas las imágenes en 
blanco y negro del lote.

Hide Grayscale (Ocultar escala de grises): Oculta todas las imágenes en 
escala de grises del lote.

Hide Color (Ocultar color): Oculta todas las imágenes en color del lote.

Si selecciona la herramienta Flag, Magnify o Draw Region (Marcar, 
Aumentar o Dibujar región) antes de hacer clic con el botón secundario del 
mouse en una imagen, aparecerán opciones adicionales en el menú.

• Si la herramienta Marcar está activa, se muestran las opciones de marcado. 
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- Flag All Selected (Marcar todas las seleccionadas): Coloca marcas de 
verificación verdes en todas las imágenes seleccionadas del lote. Para 
seleccionar más de una imagen, mantenga presionada la tecla Ctrl 
mientras hace clic sobre imágenes del visor de imágenes.

- Flag All (Marcar todas): Coloca marcas de verificación verdes en todas 
las imágenes del lote.

- Unflag All (Desmarcar todas): Quita las marcas de verificación verdes de 
todas las imágenes del lote.

- Flag Filtered (Filtrado por marca): Toma todas las imágenes filtradas 
(mostradas) y les coloca una marca de verificación verde.

• Si la herramienta Magnify (Aumentar) está activa, se muestra la opción 
Factor de ampliación. Esta opción muestra el cuadro de diálogo 
Configuración de factor de ampliación, que le permite especificar el tamaño 
de imagen que se mostrará cuando utilice la herramienta Aumentar.

• Si la herramienta Draw Region (Dibujar región) está activa, se muestran las 
opciones relacionadas con esta herramienta. 

- Apply Region to Document (Aplicar región al documento): Coloca la 
región seleccionada en todas las imágenes del documento.

- Apply Region to Selected (Aplicar región a selección): Coloca la región 
seleccionada únicamente a las imágenes que se hayan seleccionado.

- Crop (Recortar): Permite eliminar el área situada al exterior del 
rectángulo que haya creado mediante la opción Dibujar región. Al 
seleccionar esta opción, se mostrará un cuadro de confirmación.

- Blank (En blanco): Permite poner en blanco el área dentro del rectángulo 
creado mediante la opción Dibujar región. Al seleccionar esta opción, se 
mostrará un cuadro de confirmación.
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Visor de miniaturas La sección Thumbnail Viewer (Visor de miniaturas) proporciona versiones en 
miniatura de todas las imágenes del lote actualmente abierto.

Para seleccionar una imagen en el visor de imágenes:

• Haga clic en la miniatura en el visor de miniaturas.

Para aumentar una miniatura:

• Haga clic con el botón secundario del mouse en la imagen y manténgalo 
presionado. Mientras lo hace, podrá mover el área ampliada.

Menú contextual del 
visor de miniaturas

Cuando hace clic con el botón secundario sobre una imagen en miniatura, 
aparecen las siguientes opciones de menú:

Front o Back (Anverso o Reverso): Oculta todas las imágenes en miniatura 
de la parte delantera o posterior. 

Black and White, Grayscale o Color (Blanco y negro, Escala de grises 
o Color): Oculta todas las imágenes en miniatura en blanco y negro, color 
o escala de grises.

Thumbnail Image Size (Tamaño de imagen en miniatura): se mostrará el 
cuadro de diálogo Configuración de tamaño de imagen en miniatura, que 
permite modificar el tamaño de imagen.

Herramienta 
Intelligent QC

Para iniciar la herramienta Intelligent QC, selecciónela en la barra de 
herramientas Editar. Todas las imágenes seleccionadas estarán disponibles 
para su revisión y procesamiento. Si no se ha seleccionado ninguna imagen, 
estarán disponibles todas las imágenes marcadas. Otra manera de iniciar la 
herramienta Intelligent QC consiste en hacer clic con el botón secundario en 
una imagen del visor de imágenes o del explorador de lotes y, a continuación, 
seleccionar Intelligent QC en la lista.

NOTA: La herramienta Intelligent QC no está disponible mientras digitaliza 
o vuelve a digitalizar, o cuando la importación automática supervisa 
activamente la carpeta activa en busca de archivos de imagen.
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Cuando selecciona la herramienta Intelligent QC, la primera imagen se 
muestra en el panel de imágenes izquierdo. El panel de imágenes izquierdo 
muestra la imagen tal como se ve, sin ningún tipo de procesamiento adicional. 
El panel de imágenes derecho muestra cómo se vería la imagen tras el 
procesamiento.

Puede editar la imagen haciendo clic en una o más herramientas de 
procesamiento de imágenes situadas entre los paneles de imagen. 
Para deshacer una función de procesamiento de imagen, vuelva a hacer clic 
sobre ella para anular su selección.

Apply settings to next image (Aplicar configuración a la siguiente imagen): 
Si la opción está seleccionada, las herramientas de procesamiento de imagen 
seleccionadas en ese momento y la configuración de estas herramientas se 
aplicarán a la siguiente imagen, cuando corresponda. Si la opción Binarize 
(Binarización) se encuentra seleccionada y la imagen siguiente es en blanco 
y negro, no se aplicará la binarización. Sin embargo, si la opción Hole Fill 
(Llenar orificios) también se encuentra habilitada, se aplicará a la imagen en 
blanco y negro.

Apply To All (Aplicar a todo): Aplicará las herramientas de procesamiento de 
imagen seleccionadas a todas las imágenes seleccionadas con la 
herramienta Intelligent QC.

Next (Siguiente): Esta opción está disponible si hay imágenes adicionales 
para revisar. Si hace clic en Next (Siguiente), se guardará la imagen actual tal 
como se muestra en el panel de imágenes procesadas. Si se activa la casilla 
de verificación Apply to Next, se aplicarán las herramientas de 
procesamiento de imagen seleccionadas a la siguiente imagen. La imagen 
antes de procesar se mostrará en el panel de imágenes Original (Original), 
mientras que la imagen procesada se mostrará en el panel de imágenes 
Processed (Procesada). 

Back (Atrás): Muestra la imagen que se ha visualizado anteriormente. 
Se desactivarán todas las selecciones de herramienta y se desactivará la 
casilla de verificación Aplicar a siguiente. La imagen se mostrará tal como se 
mostraba cuando se seleccionó el botón Next (Siguiente).
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View B&W y View Grayscale/Color (Ver en blanco y negro y Ver en escala 
de grises/color): Cuando hay una imagen en escala de grises/color y una 
imagen en blanco y negro asociada (salida simultánea), la imagen en blanco 
y negro se muestra en el panel de imágenes Original. Para ver la imagen en 
escala de grises o en color, haga clic en el botón Ver en escala de grises/
color.

Ventana Índice Para su conveniencia, la ventana Índice de la parte derecha del visor de 
imágenes contiene los datos del índice de cada lote y documento que tenga 
índices definidos. Está disponible como pestaña desplegable en el lado 
derecho de la pantalla. Los datos del índice pueden mostrarse brevemente 
(sobre el punto de tabulación) o de forma opcional fijados a la imagen para ver 
de forma continua los campos del índice de todas las imágenes en el 
momento en el que se están digitalizando en el software Capture Pro. Puede 
usar esta función para ver los campos de índice de un documento específico 
o del lote completo. Si quiere hacer correcciones en el contenido de cada 
campo de índice, debe ingresar al modo de indexación. Para hacerlo, 
seleccione Editar campos de índice en el menú Índice. 

Para abrir la ventana de Índice:

• Haga clic en la pestaña Index (Índice) de la parte derecha del visor de 
imágenes. Para evitar que se cierre la ventana, haga clic una vez en el 
icono Fijar en la esquina superior derecha de la ventana.

Para cerrar la ventana Índice:

• Haga doble clic en el icono Fijar o en cualquier lugar de fuera de la ventana 
Índice. Si la ventana se fijó para quedar abierta, haga clic en el icono Fijar 
una vez para cerrarla.
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Ventana Información La ventana Information (Información) del lado derecho del visor de imágenes 
proporciona estadísticas sobre el lote abierto. También puede dejar fijada la 
ventana Información en posición abierta para ver de forma continua las 
estadísticas de los lotes a medida que se digitalizan en el software Capture Pro.

La información de esta ventana se puede visualizar en relación con el lote, con 
cada documento, con cada página o con cada imagen. La información de la 
imagen incluye el número de secuencia de imagen, la ID de página, la 
ubicación en el disco, la compresión, la resolución, el tamaño de imagen y la 
cadena de impresión.

Para abrir la ventana Información:

1. Resalte una imagen, página o documento del explorador de lotes, 
o resalte una imagen del visor de imágenes.

2. Haga clic en la ventana Información de la parte derecha del visor de 
imágenes. Para evitar que se cierre la ventana, haga clic una vez en el 
icono Fijar en la esquina superior derecha de la ventana.

Para cerrar la ventana Información:

• Haga doble clic en el icono Fijar o en cualquier lugar fuera de la ventana 
Información. Si la ventana se fijó para quedar abierta, haga clic en el icono 
Fijar una vez para cerrarla.

Ventana Estado de 
procesamiento de lote

La ventana Batch Process Status (Estado de procesamiento del lote) de 
Capture Pro proporciona información sobre los lotes que se están preparando 
para su generación.

Haga clic en Control (Control) para abrir el menú Control, que incluye las 
siguientes opciones:

• Show Log (Mostrar registro): Abre una ventana del Bloc de notas y muestra 
el registro de generación.
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• Clear Log (Borrar registro): Elimina todas las entradas del registro de 
generación. Aparecerá un cuadro de confirmación para que verifique su 
selección.

• About (Acerca de): Abre el cuadro de diálogo con información acerca del 
software Capture Pro, que incluye un comando para visualizar todos los 
archivos del software Capture Pro.

• Exit (Salir): Abre el cuadro de diálogo Opciones de cierre, que contiene 
comandos para salir del software Capture Pro. El procesamiento de 
generación se realiza en segundo plano y de forma independiente del 
software Capture Pro. Si cierra el software Capture Pro, se le pedirá que 
continúe o detenga el procesamiento de generación.

La ventana Batch Process Status (Estado de procesamiento del lote) de 
Capture Pro proporciona la siguiente información sobre cada lote que se ha 
generado o que se encuentra en proceso de generación: Job Name, Batch 
Name, Submit Time, Status, User Name, Progress y Description (Nombre 
de trabajo, Nombre de lote, Hora de envío, Estado, Nombre de usuario, 
Progreso y Descripción).

• Haga clic con el botón secundario sobre una entrada Batch Name (Nombre 
del lote) de la cuadrícula y elija Clear All Errors (Borrar todos los errores) 
o Clear Selected Errors (Borrar los errores seleccionados).

Para ver la ventana Batch Process Status (Estado de procesamiento del lote):

• Seleccione Batch > View Batch Output Status (Lote > Ver estado de 
generación del lote).

Barra de estado La barra de estado del software Capture Pro proporciona información sobre el 
lote actual, el documento actual y el espacio libre disponible en el disco, 
e indica si los filtros del visor están activados o desactivados. La barra de 
estado está situada en la parte inferior de la pantalla y puede activarse 
y desactivarse si se marca o desmarca la opción Status Bar (Barra de estado) 
en el menú Ver o se utiliza el método abreviado Ctrl + S.

La barra de estado muestra el espacio disponible en el disco en MB, el 
número de documentos, páginas e imágenes que hay en el lote actual, el 
número de imágenes del documento que se está mostrando en la ventana 
visor de imágenes y el estado de los filtros de imágenes.

Si el filtro de imagen está activado, esto indica que los tipos de imágenes 
como “fondos de imagen” o “imágenes en escala de grises” no aparecen 
seleccionadas en el menú Ver > Filtro del visor de imágenes.

Cambio de la interfaz 
de la ventana 
principal

Conforme se digitalicen las páginas, aparecerán las imágenes en todos los 
visores mostrados: el visor de imágenes, el visor de miniaturas y el explorador 
de lotes. El software Capture Pro tiene dos diseños de pantalla 
predeterminados: clásico y ampliado. 

El software Capture Pro le permite desplazar las barras de herramientas, los 
visores, etc., para personalizar el diseño de la ventana principal, de manera 
que se ajuste a sus preferencias y le permita ocultar cualquier componente no 
deseado de la pantalla.
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Estas opciones se aplican al Visor de imágenes, el Explorador de lotes, el 
Visor de miniaturas, la ventana Información y la ventana Índice. Estos iconos 
están ubicados en la esquina superior derecha de estas ventanas:

El tamaño de las imágenes dentro de los visores se puede especificar según 
las necesidades. El visor de imágenes se puede definir para un tamaño fijo 
o mantener el ajuste predeterminado Mejor ajuste, que muestra las imágenes 
con el mejor tamaño posible para la pantalla. 

Las barras de herramientas y las ventanas de las imágenes se pueden mover 
u ocultar como desee. El software Capture Pro recuerda la configuración de 
cada trabajo cuando sale de él. Esto quiere decir que se pueden mostrar 
distintos trabajos con distintas disposiciones. En cualquier momento, puede 
seleccionar View > Layout > Classic o Enhanced (Clásico o Ampliado) 
y restablecer la pantalla al diseño predeterminado.

Si está utilizando el diseño Clásico y desea agregar una ventana del diseño 
Ampliado, abra el menú Ver y seleccione una ventana (por ejemplo, el 
explorador de lotes o la ventana Índice). La ventana adicional se mostrará en 
diseño Clásico.

Cierra cualquier ventana. Para volver a abrir la ventana, 
seleccione la ventana que quiera mostrar en el menú Ver.

Fija la ventana para que quede abierta. Para ocultarla 
automáticamente, haga clic en el icono Fijar.

Oculta automáticamente la ventana, dejando únicamente la 
barra de título abierta. Para mostrar la ventana, mueva el cursor 
sobre la barra de título.

Los iconos de anclaje (representados por cuatro puntos 
verticales) están situados en la esquina superior izquierda de 
las ventanas. Cuando se selecciona un icono de anclaje y se 
mantiene presionado el botón del mouse, el anclaje de la 
imagen se libera y aparecen flechas azules de posicionamiento. 
Mientras mantiene presionado el botón del mouse, puede mover 
la ventana a una nueva ubicación. Cuando la ventana esté 
donde desee, suelte el botón del mouse.
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• Diseño clásico: Muestra solo el visor de imágenes. Puede seleccionar el 
número de imágenes visualizadas entre 1, 2, 4, 8 o personalizado (hasta 6 
columnas y 6 filas).

• Diseño ampliado: Muestra el Visor de imágenes, el Visor de miniaturas y el 
Explorador de lotes. Puede ajustar el tamaño de cada ventana a su gusto.
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3   Solución de problemas

Servicio técnico Puede encontrar servicio técnico para el software Capture Pro en el sitio web 
de Kodak Alaris: www.alarisworld.com/go/CaptureProSupport. Las páginas de 
servicio técnico proporcionan información específica sobre los productos, 
como acceso a descargas de mejoras, controladores, accesorios y acceso 
a las preguntas frecuentes, además de detalles sobre las opciones de servicio 
técnico para el software Capture Pro disponibles en su país/región.

 

www.kodakalaris.com/go/CaptureProSupport
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Anexo A   Métodos abreviados del teclado

Según el lugar en el que esté trabajando con el software Capture Pro, estarán 
disponibles los siguientes métodos abreviados del teclado:

• F1-Ayuda está disponible en todo el software Capture Pro.

• Explorador de lotes/visor de imágenes. Están disponibles los siguientes 
métodos abreviados:

Generales

J Configuración de trabajo

F2 Mostrar lista de configuración de página

F5 Mostrar configuración de página

F3 Abrir lote

F7 Iniciar captura

F6 Detener captura

Intro Capturar nuevo documento

Ctrl+Intro Capturar nuevo documento

O Generar lotes

Ctrl+Mayús+W Cerrar lote

Ctrl+S Mostrar/ocultar barra de estado

Ctrl+P Imprimir

Visualización y edición

A Ver tamaño real de la imagen

F Ajustar imagen a la ventana

1, 2, 4 u 8 Establecer el número de imágenes que se mostrarán 
en el visor de imágenes

Ctrl+F9 Mostrar/ocultar imágenes en color 

Ctrl+F10 Mostrar/ocultar imágenes en escala de grises 

Ctrl+F11 Mostrar/ocultar imágenes en blanco y negro 

Ctrl+A Seleccionar todas las imágenes (explorador de lotes)

Ctrl+D Desmarcar todas las imágenes (explorador de lotes)

Ctrl+F Seleccionar todas las imágenes marcadas (explorador 
de lotes)

F4 Adjuntar página (documento seleccionado)

Insertar Insertar páginas en la página seleccionada

Del Eliminar documento seleccionado o páginas 
seleccionadas

F8 Eliminar documento seleccionado

C Seleccionar herramienta de marca

M Seleccionar herramienta de ampliación

P Seleccionar herramienta de desplazamiento

S Seleccionar herramienta de selector
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Visualización y edición (continuación)

Desplazar arriba

Desplazar a la derecha

Desplazar abajo

Desplazar a la izquierda

Mayús+ Girar 180°

Mayús+ Girar 90°

Mayús+ Girar 180°

Mayús+ Girar 270°

+ Acercar

- Alejar

Ctrl+L Dividir documento (explorador de lotes)

K Configuración de la eliminación de imágenes en 
blanco

R Volver a digitalizar imágenes seleccionadas

Z Seleccionar herramienta de región de dibujo

Ctrl+B Poner en blanco región seleccionada

Ctrl+R Recortar región seleccionada

Ctrl+Z Deshacer último recorte o puesta en blanco

Ctrl+I Copiar área de imagen

Exploración

D Ir a documento número…

I Ir a imagen número…

Explorador de lotes

Ctrl+Inicio Primer documento del lote

Ctrl+Fin Último documento del lote

Ctrl+Re Pág Documento anterior del lote

Ctrl+Av Pág Siguiente documento del lote

Visor de imágenes

Inicio Primera página del documento

Fin Última página del documento

Re Pág Páginas anteriores (todos los documentos)

Av Pág Páginas siguientes (todos los documentos)

• Modo de indexación: Están disponibles los siguientes métodos 
abreviados:

E Editar campos de índice

F9 Documento anterior

F10 Documento siguiente

F11 Siguiente documento no válido

F12 Guardar indexación y salir

Esc Cancelar indexación y salir
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